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Overview 
Welcome to the OnTraQ module in Traffic Analyst! OnTraQ is designed to be 
ready to use out of the box after implementation is complete. Your route control 
groups and ACD groups defined on your switch are imported by OnTraQ and 
displayed as Service Groups and Agent Teams in OnTraQ, so you can see 
information about them in OnTraQ as soon as you select them for monitoring.  

This document assumes the CAP Server has been configured for use with 
OnTraQ and that the OnTraQ server has been set up. If not, contact Impact 
Technologies Customer Service for assistance.  

This guide contains the following chapters: 

Section 1:  Administrative Tasks discusses initial setup and configuration 
options you will use to prepare OnTraQ for daily use, including selecting the 
Service Groups and Extensions that will be monitored by OnTraQ. You will learn 
how to define sessions, set alarm colors, and more. You may want to define 
some organization-wide Service Groups and Agent Teams, and perhaps add 
names to the Agent IDs, or you may prefer to let each OnTraQ user define the 
groups and teams he or she will be monitoring.  

Section 2:  User Tasks discusses the options users will perform with OnTraQ on 
a day-to-day basis. You will learn how to build Service Group Pools, Agent 
Teams, how to view your OnTraQ data and how to modify the way data is 
displayed within OnTraQ, including OnTraQ reports. 

Section 3:  OnTraQ Data Dictionary describes the data elements that you will 
use to create dynamic and historical displays in OnTraQ.  

Section 4: Appendix: Menu Options describes the menu options available from 
the main OnTraQ display.  

This document stresses the process and flow of activities, without trying to 
explain everything you see on-screen. OnTraQ is easy to use and the displays of 
data are intuitive. You choose the data to display and how to display it.  
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Section 1: Administrative Tasks 
This section discusses the administrative tasks you will perform to ready OnTraQ 
for daily use.  

1.1. Creating OnTraQ User Accounts 
To create OnTraQ user accounts, you need to do so in Traffic Analyst Admin 
Server. Go to the Traffic Analyst Admin Server and select the System – Users 
option. The Users window displays.  

 

Figure 1: Traffic Analyst Users window 

This is the window where you define Traffic Analyst users. Users can belong to a 
group which defines their level of privileges within OnTraQ and other Traffic 
Analyst modules. The groups are:  

System Administration, which allows a user complete permission to perform 
any OnTraQ action. 

Web Account Admin, which allows a user permission to perform any OnTraQ 
action within that user’s assigned Account.  

Standard User, which allows access to all options except to the Configure 
OnTraQ Servers option, ACD Object Access option, ANI/DNIS Groups option, 
and Transaction Codes option. In addition, the System Preferences and Service 
Group Thresholds options are view-only for Standard Users.  

Reports Only, has the same user privileges as a Standard User. We 
recommend that you use the Standard User designation rather than Reports 
Only, however.  

The Access Control section is where User IDs are assigned permissions to 
features and switches. 

Note that the Pager section does not apply to OnTraQ. OnTraQ alarms will be 
displayed within the OnTraQ module but will not trigger pager and email alerts.  
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1.1.1. User Accounts 
The User Accounts window defines accounts and allows Web Admin users to be 
set up for new accounts. Accounts have assigned switches and features that can 
be accessed by a particular user. When a switch is assigned to an account, that 
account name will appear in brackets to the right of the switch name in Traffic 
Analyst. Select the System – User Accounts option. The following window 
displays.  

 

Figure 2: Traffic Analyst User Accounts window 

Enter the Max Switches and Max Users to designate the maximum number of 
switches and users that can be assigned to the account.  

Choose the Feature Access and Switch Access buttons to set which switches 
and features are viewable in this account. Available features, including OnTraQ, 
are determined by the Traffic Analyst modules you have purchased.  

You also can create a new user in your dashboard client. To do this, go to Tools, 
Users, and then select All Users. To add a new user, click “New” button from All 
Users screen and the window below appears.  Enter the user data, select the 
switches the user should have access to in the Explorer tree and feature access 
(typically Network and/or Call Detail).  

 



 ONTR AQ US E R  GUI DE   

MAR CH  2017  IM P AC T  TE CH N O L OG I ES ,  I N C.  9  

 

Figure 3: Creating a new user  

1.2. Defining OnTraQ’s Primary Hours and Days in Traffic Analyst 
When you create reports in OnTraQ, you select day and hour types as part of the 
reporting criteria. OnTraQ recognizes Primary Days and Primary Hours, as well 
as Non-Primary Days and Hours too. Primary Days and Hours are defined in 
Traffic Analyst in the Switch Properties on the Definition tab. Define these report 
criteria as part of your OnTraQ setup tasks.  

 

Figure 4: Switch properties  

In the Primary Days area, select the days that will define your organization’s 
Primary Days by putting a check in the checkbox under the day. Also define 
Special Days (e.g., holidays) as being Non-Primary by selecting that checkbox.  

In the Primary Hours fields, enter the time range that will define your 
organization’s Primary Hours.   
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1.3. Administrative Setup in OnTraQ 
After you set up user accounts in Traffic Analyst Administrator, you are ready to 
begin doing administrative setup work in OnTraQ. You will have to start OnTraQ 
and log in before you can perform these administrative tasks. See 2.1.1 Logging 
In on page 22 for information on starting OnTraQ and logging on. 

Some of the global settings within OnTraQ you may wish to set up before anyone 
else uses OnTraQ include Alarm Colors and Sounds, Session Boundaries, 
queue bands, how long some kinds of data will be retained, and the URL that will 
provide OnTraQ access to Traffic Analyst.  

Note: When an OnTraQ server is connected directly to an IPDA, the time zone of 
the host PC must be set to the time zone of the OpenScape/HiPath 4000, not the 
local time zone of the IPDA.  This is because the event received by OnTraQ from 
the switch (through CAP) uses the switch’s time zone. 

1.3.1. Session Boundaries (shifts) 
You can define Session Boundaries in OnTraQ to reflect the shift times your 
organization uses. This will organize the information OnTraQ displays in a way 
that mirrors the shifts your organization members’ work.  

Go to Tools – System Preferences to define Session Boundaries. The System 
Preferences window displays.  

 

Figure 5: System Preferences (Session Boundaries) 

You can define up to four Session Boundaries to mirror the work shifts within 
your organization. Enter a Begin Time and an End Time to define each Session, 
which can be identical to your work shift begin and end times. You must enter the 
time in the HH:MM format and include an AM or PM. 
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1.3.2. Time-In-Queue Bands 
Time-In-Queue Bands allows you to organize the way call queue times are 
sorted and grouped by OnTraQ.  

You can define up to four Time-In-Queue Bands for your organization. These are 
defined in seconds. To define these bands, go to Tools – System Preferences. 
The System Preferences window displays.  

 

Figure 6: System Preferences (Time-In-Queue Bands detail) 

Enter the End of Band for each band. In the example above the first Time-In-
Queue Band is the initial five seconds of the call, the second Time-In-Queue 
Band will be for calls that have been in queue for more than five seconds and 
fewer than ten seconds, and so on. 

1.3.3. Data Storage Time Frames 
The Data Storage Time Frames lets you define for how many days data will be 
stored for the Life of Call and Event Log reports.   

1.3.4. Reporting Web Service Discovery URL 
This URL is simply the URL that OnTraQ will use to access Traffic Analyst.  

1.3.5. Alarm Colors and Sounds 
The Alarm Colors and Sounds are defined for all OnTraQ users by the OnTraQ 
administrator. When alarm conditions are met, an alarm will display and sound. 
(Your OnTraQ users will individually define the Alarm Thresholds for the groups 
and agents they monitor.) 

To change the Alarm Colors and Sounds, select the Alarm button from the button 
bar on OnTraQ’s main window. The Alarm Colors/Sounds window displays.  
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Figure 7: Alarm Colors and Sounds 

To change a sound, select the Browse button and locate the sound file you wish 
played when the alarm condition is met. Sound files must be WAV files that are 
formatted as PCM (8 bit or 16 bit sampling) or ADPCM (4 bit sampling).  

To change a color, select the Change button to the right of the alarm state you 
wish to change. The Color window displays (this is a standard Windows option).  

 

Figure 8: Standard Windows Color window 

Use this window to change the color associated with the Alarm Threshold. You 
can click on a color swatch in the grid to select that color, or use the larger color 
display to select a custom color.  

1.3.6. Common Organization Definitions 
OnTraQ imports Route Control Groups and Agent ID information from your 
switch. Route Control Groups are renamed Service Groups in OnTraQ, but 
otherwise are the same. Route Control Groups are created on your switch by 
your switch administrator. Typically, a Route Control Group will be used to route 
calls to the appropriate extensions.  

Your OnTraQ users are not limited to these groupings, however. They can create 
new Service Group Pools which are comprised of multiple Service Groups.  

Your OnTraQ users can also group the Agent ID information into Agent Teams. 
Initially, all the Agent IDs are imported. The ACD Groups defined on the switch 
are imported and the agent IDs associated with those groups are stored in 
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OnTraQ as separate Agent Teams. In other words, each ACD Group on the 
switch will be represented by a corresponding Agent Team within OnTraQ. All of 
the agent IDs on the switch are also imported and stored together in another 
Agent Team.  

This all-inclusive Agent Team is there as a convenience. You can also create 
new Agent Teams and copy the Agent ID information into these teams through a 
simple drag-and-drop utility. You may find it easier to reference the all-inclusive 
Agent Team when creating new Agent Teams rather than trying to find the Agent 
IDs you want in the various Agent Teams created from ACD Groups.  

While your OnTraQ users may want to create their own Service Group Pools and 
Agent Teams, there may be some groups and teams you want to create 
beforehand.  

We recommend that you adopt naming conventions for renaming Agent IDs and 
for naming Service Group Pools so that your OnTraQ users will be consistent 
when they apply new names to Agent IDs and other objects.  

1.3.6.1. Service Groups and Pools 
The Route Control Groups that OnTraQ imports are called Service Groups by 
OnTraQ. Route Control Groups are set up to route calls, so your switch 
administrator may create a route control group for sales calls, one for service 
calls, etc. OnTraQ will mirror this structure when it imports. The benefit of Service 
Groups in OnTraQ then is that it gives you a way to monitor and measure types 
of calls. You may very well have different service goals for sales calls as 
opposed to customer service calls, for example. Service Groups help you sort the 
call information.  

In addition, you can also create Service Group Pools which include more than 
one Service Group. This allows you to organize your OnTraQ information in ways 
that make sense for your organization and which will allow you to more quickly 
view the information you want to see.  

For example, you might create a Sales Service Group Pool and include a Sales 
Service Group, a Sales Engineering Service Group, and an After Sale Support 
Service Group in it.  

You can also create Service Group Pools (and Agent Teams) that are comprised 
of Service Groups (and Agents) from different telephone switches. These “cross-
switch” Pools and Teams can only be used in historical reports and not in real-
time displays. Further, historical data for these cross-switch teams will only be 
available starting the next day.  

For more information on creating Service Group Pools, see 2.2.1.1 Creating 
Virtual Groups.  

1.3.6.2. Agent and Agent Teams 
OnTraQ imports Agent IDs and ACD Groups from your switch. You can add the 
actual agent names in OnTraQ. Each ACD Group on your switch will be 
displayed as an Agent Team in OnTraQ.  
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Since you can rename Agent IDs, you may want to define a naming convention 
for all OnTraQ users to employ so that the Agent IDs, as represented in OnTraQ, 
are similar.  

In addition, you can create Agent Teams to group agents in various teams. In 
fact, an agent can belong to more than one team.  

For example, you might have five new agents in your customer service group. 
You would probably want them to be in your Customer Service Agent Team, but 
you might also want them in a group labeled “New Agents” so you can more 
quickly monitor their status.  

For more information on creating Agent Teams, see 2.2.2.2 Creating Virtual 
Teams.  

1.3.7. ACD Object Access 
The ACD Object Access option, found under the Tools menu, lets you define the 
Agent Teams, Agent IDs (or agent names if you have renamed IDs), and Service 
Groups that an individual OnTraQ user can see and access.  

 

Figure 9: The ACD Object Access window 

By default, new users will not have access to any agents or groups. You need to 
give them access to selected agents or groups, or give them access to all agents 
or groups.  

To grant selective access to agents or agent teams, find the agent or agent team 
in the selection tree and click on the name if the name is grayed out. Any grayed 
out name means that the user does not have access.  

To restrict access to an object, click on it and it will turn gray to indicate that the 
user will no longer have access to it. If you click on an Agent Team name, all the 
Agent IDs in that team will turn gray. You can also choose to restrict access to 
individual Agent IDs by clicking on them.  
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You can also right-click on an object and get an option to grant or limit access to 
that object to all users.  

The same steps can be used to restrict access to Service Groups as well.  

1.3.8. Object Monitoring 
The Object Monitoring option, found under the Tools menu, lets you select which 
Service Groups and Extensions will be monitored by OnTraQ.  

The default is that none are monitored, so you will need to use this option to 
select Service Groups and Extensions for monitoring after OnTraQ is installed  

 
Figure 10: Object Monitoring window 

You can quickly choose to monitor all Service Groups by clicking on the Monitor 
All Service Groups button. Likewise, you can choose to not monitor all Service 
Groups by clicking on the Stop Monitoring All Service Groups button. The Restart 
All Monitored Service Groups button will stop and restart all currently monitored 
Service Groups.  This is typically used for implementations when the CAP server 
stops sending events for one or more Service Groups. Note that you can also 
right mouse click on a Service Group in the Explorer tree and select the “Restart 
Monitor” option to stop and start a single Service Group.  
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The Monitored and Unmonitored checkboxes let you see the list of Service 
Groups displayed in this window.  

To monitor or stop monitoring selected Service Groups, click on the group name 
in the list. If a name is grayed out and highlighted, it means it is not being 
monitored. Clicking on the group name toggles its monitor status.  

Right-clicking on a Service Group name gives you several options – including 
monitoring all or monitoring none of the Service Groups.  

The Extensions button allows you to toggle the display from Service Groups to 
Extensions. The monitoring options discussed above work in a similar method for 
Extensions, both for Primary and 2nd Lines.  

The license information at the bottom of this window displays the number of 
extensions being monitored and your licensed capacity. If you need to exceed 
your licensed capacity, you will need to purchase additional licensing.  

1.3.9. ANI/DNIS Groups 
The ANI/DNIS Groups option, found under the Tools menu, lets you define the 
ANI/DNIS groups that will then be available for use in your Service Group 
reports.  

ANI stands for Automatic Number Identification, which in OnTraQ refers to the 
phone number of the calling party in a Service Group call. DNIS stands for Dialed 
Number Identification Service, which in OnTraQ refers to the phone number 
dialed to reach the Service Group. 

You don’t need to define ANI/DNIS Groups, but it does give you a way of 
subdividing the calls that come into your organization for tracking purposes.  

 
Figure 11: The ANI/DNIS Groups window 

To create an ANI/DNIS Group, type the name of the group you wish to create in 
the ANI/DNIS Group field and then click Insert New Rule. A dialogue box will pop 
up asking you to confirm the creation of the new group. Select Yes. The group is 
now created. 

A blank row has also appeared in the ANI/DNIS Rules display. Now, you can add 
ANI and DNIS rules that will track specific kinds of calls and callers for this group.  

Under the Type heading, select either ANI or DNIS from the drop-down menu. 
Under Digits to Filter, enter a string of digits (e.g. area code) that will match what 
the ANI or DNIS phone number starts with. 
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Use Length and Length Comparison to enter rules for the length of the phone 
number. For example, if you have entered an area code in the Digits To Filter 
field, you might set the Length field to 10 digits and the Length Comparison field 
to Longer Or Same Length. By doing so, phone numbers that are not within the 
area code, but begin with these digits (e.g. internal, local) would be filtered out. In 
the example above, for instance, a call from extension 3144 would not be 
accidentally lumped in with calls from the area code 314. 

To add additional rules, click on Insert New Rule. 

When you have finished creating the group, click Apply at the bottom of the 
ANI/DNIS Group screen. You may then exit the screen, or click Create New 
Group to add another new ANI/DNIS group. 

Use the Delete column to delete a rule. To delete an entire ANI/DNIS Group, use 
the Delete button to the right of the ANI/DNIS Group field.  

Use the ANI/DNIS Group drop-down menu to select groups for editing.  

1.3.10. Transaction Codes 
The Transaction Codes option, found under the Tools menu, lets you define the 
Transaction Codes that OnTraQ will display in the Transaction Code report.  

You define the codes, in the form of the digits your agents enter to designate 
calls, and assign labels to each code. OnTraQ then matches the codes you 
defined to the codes it sees in the data coming over from the switch.   

 
Figure 12: Transaction Codes 

To define a Transaction Code, click on Insert New Code. A blank row will display. 
Enter a name for the code in the Code Name column and then enter the digits 
that correspond to the digits your agents use when assigning that code to a call.  

1.3.11. Custom Routing 
Custom Routing, found under the Tools menu, supports integration to a 
customer-specific database via an ODBC Connector.  The integration supports a 
lookup to route calls to a specific Service Group or agent based on the incoming 
ANI.  Please contact Impact Technologies Customer Support for additional 
information.   
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1.3.12. Number Translations 
The Number Translations option, found under the Tools menu, allows you to add 
digits to ANI and DNIS numbers for display purposes.  For instance, you can 
expand a four digit dialing scheme to be displayed as 7 or 10 digits by 
prepending the NXX or NPANXX, respectively.   

 

1.4. Maintaining OnTraQ servers 
During implementation, OnTraQ was configured to connect to your switch(es). 
Should you need to change any of this configuration information, select the File – 
Configure OnTraQ Servers option. The OnTraQ Servers window displays.    

 
Figure 13: OnTraQ Servers 

To edit existing server information, double click on the server displayed in the 
bottom of the window. The fields display the server configuration information. To 
change the information, edit any of the fields and then select the Update Server 
option.  

 Host Address – the IP address (IPV4 only) or Computer Name of the 
OnTraQ server  

 Server Name – any descriptive name you want to give it  

 Switch – the Traffic Analyst switch 

 IPDA # - Only applicable if the OnTraQ server directly connected to 
IPDA, the IPDA number. An IPDA is a remote switch access point 
connected to the switch via IP.  It can act like an independent switch.  
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 Dialed # Prefix – the number used to dial into the switch (Please note 
only applicable for OpenScape/HiPath 4000. As this is a phone number 
you are entering, you do not need to include a trunk access number, 
such as a 9.) The format you must use is:  
 
    Single area code:  +1(area code)prefix   For example: +1(314)743 

Multiple area codes with 10-digit extensions:  +1  

 CAP/Message Host – IP address of the CAP Server for 
OpenScape/HiPath 4000 or IP address of UCCX/UCCE server for Cisco 

 CAP/Message Port – IP port for the CAP Server for OpenScape/HiPath 
4000 or UCCX/UCCE server for Cisco 

 Username – this must match the username on the CAP server or 
username for UCCX/UCCE.  

 Password – this must match the password on the CAP server or 
UCCX/UCCE server.  

 CAP Connect Delay – the time that OnTraQ waits before attempting to 
connect to the CAP server. The default is 60 seconds. Applicable only for 
OpenScape/HiPath 4000. 

 SCC ID  (from CAP) – SCC configured in CAP.  Applicable only for 
OpenScape/HiPath 4000.  

To delete the server, select the Delete Server option.  

To copy the server, select the Create New option and then edit the information. 

1.5.  Custom Agent States 
OnTraQ gives you the ability to define custom agent states for when agents are 
in Work or Unavailable states. Only Administrators have the ability to create and 
edit custom states.  

Custom Agent States allow you to drill deeper into Current and Historical 
Reports, as well as providing you with the greater understanding of what agents 
are doing when they are, for example, in an Unavailable state for an hour, or a 
Work state for two hours. 

1.5.1. Creating Custom Agent States 
To create a custom agent state, click on the Tools dropdown menu and select 
Custom Agent States. The Custom Agents States window will display. Select a 
blank State field, such as 7 in the example below, and choose either Unavailable 
or Work from the dropdown. 
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       Figure 14: Custom Agent States  

Next, choose a Name for this custom state. Remember to choose a name that 
describes what agents in this state are doing. In number 7 of this example, the 
name is Special Project. Because 7 is a Work state, it is obvious that any agents 
in this custom state are working on a special project. 

Finally, if you would like to mark a custom agent state as the Default (i.e. the 
state an agent is automatically placed in when their ACD line is set to 
Unavailable or Work) simply check the Default box. 

Note: When utilizing Custom Agent States, the administrator must assign one 
Work and one Unavailable state (assuming they are creating both) as the default, 
so the system knows which one to set in the automatic assignment case. If 
Custom Agent States is not being used, the preexisting Work and Unavailable 
states are already defaulted. 

When you are done creating a custom agent state, click OK for the changes to 
take effect. 

Note: You do not need to specify whether a custom state is an Unavailable or 
Work state in the Name field. The Activity Log and Reports pages automatically 
concatenate the State and Name (e.g. Work – Special Project). The Work and 
Unavailable columns in the Agent Team Display have State fields that indicate 
custom states. 

1.5.2. Editing Custom Agent States 
You may edit Custom Agent States very easily by going to the Tools – Custom 
Agent States option. However, we suggest that you avoid making major changes 
to custom states that already exist, because this can affect data in Historical 
Reports. 

If you wish to edit a custom state, access the Custom Agent States window and 
click on the field you would like to change. This is particularly useful in the case 
of fixing typos or adding detail to a custom state. For example, let’s say you want 
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to add a second Work – Special Project state. You may wish to edit the Name of 
the first custom state to be Special Project 1, and when you create the second 
custom state, you could label it Special Project 2.  

Unless completely necessary, we recommend not changing the State field for 
custom states. 

 

1.6. Distributing reports: The OnTraQ Report Viewer 
When your users create OnTraQ reports, they can distribute the reports to others 
in your organization who do not have the OnTraQ client installed through four 
different methods: 

• The report output can be saved in an Excel spreadsheet format (.xls, 
.xlsx). 

• The report can be saved in Adobe Acrobat format (.PDF). 

• The report can be saved in XML Paper format (.xps). 

• The report output can be saved in a native OnTraQ report format (.otr). 

If users save the output in an Excel, XML, or PDF format, it’s simply a matter of 
distributing the saved file to anyone who wants to view it in that format.  

If users save the output in OntraQ’s native format, others in your organizations 
will need the OnTraQ Report Viewer to view the report file. This is a standalone 
report viewer that is free to download from Impact Technologies’ website at 
http://www.impacttech.com/ontraqsupport/. 

Once the Report Viewer is downloaded and installed, it creates a desktop icon. 
You can start the Report Viewer by double-clicking the desktop icon or right-
clicking it and selecting the Run option. Once started, you can open an OnTraQ 
report from the File menu, though you will need to know the location of the file 
you want to open.  

An alternative method of starting the Report Viewer is to double-click the OnTraQ 
report file you want to view. If the Report Viewer is installed, double-clicking the 
report file will open the Report Viewer and display the report file.  

 

http://www.impacttech.com/ontraqsupport/
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Section 2: User Tasks 
This section discusses some of the ways in which you can use OnTraQ on a day-
to-day basis in your organization. 

OnTraQ is extremely flexible in the way in which you can view the information it 
tracks. There isn’t a right or wrong way to view this information, so think of this 
section as offering some guidelines. To really get the most use from OnTraQ, 
determine what information is most important and build your OnTraQ displays 
around that goal.  

2.1. Getting Started and Basic Concepts 
OnTraQ organizes your switch data into Service Groups and Agent Teams. You 
can even arrange several groups into a Service Group Pool. In the same 
manner, you can create new Agent Teams and group them together under other 
teams.  

Also note that these groups and teams can appear in more than one place in 
OnTraQ. For example, you may want to have quick access to a group dedicated 
to after-sales support. You might group them under both a Sales Service Group 
Pool and a Customer Service Service Group Pool so you can access their data 
quickly, no matter what Service Group Pool you are viewing.    

The following pages detail how to access OnTraQ and build and use your groups 
and teams.  

2.1.1. Logging In 
To log in to OnTraQ, click Start – Programs - OnTraQ. The OnTraQ Client Login 
window displays. 

 

Figure 15: OnTraQ Client Login window 

Enter the IP address of an OnTraQ server and your Username and Password.  

The IP address should be listed in the drop-down list. If it isn’t listed, you can 
enter it directly by typing it.  

The default username is traffic and the default password is impact.  
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After entering the information, click Login to start OnTraQ. The OnTraQ window 
displays. It will initially be blank, but the screen layout you have when you log out 
of OnTraQ will be reproduced when you log in again.  

2.1.2. Logging Out 
To log out of OnTraQ, go to File – Logout. The Confirm Logout window displays: 

 

Figure 16: The Confirm Logout window 

If you have made any changes to the default layout, you can save those changes 
so that next time you log in, the OnTraQ display will be as you left it. To save 
those changes, select the Save Current Window Layout checkbox.  

Note: Multiple historical reports cannot be saved to the window layout. 

2.1.3. OnTraQ’s “Tablet” (MDI) 
The window OnTraQ operates in is referred to as a Multiple Document Interface, 
or MDI. Essentially, this means that OnTraQ consists of a main window which is 
subdivided into smaller paned windows. Each pane is a separate display. Since 
Panes can be overlaid on top of one another, Panes that are behind other panes 
will be accessible through tabs.   

For our purposes, we will refer to this main OnTraQ window as the “Tablet.” This 
Tablet can consist of multiple window panes.  

OnTraQ is very flexible in the way it displays its information. Two OnTraQ users 
may choose to view information differently, and the result may be two OnTraQ 
tablets that look very dissimilar.  
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Figure 17: OnTraQ's Tablet with several panes displayed 

2.1.4. Viewing Panes and Wallboard Displays 
OnTraQ information is always displayed in a pane, though you can make a pane 
into a separate window outside of the OnTraQ Tablet.  

The following sections describe the different options you have for working with 
OnTraQ’s panes.  

2.1.4.1. Right-Click Options with Panes 
If you right-click with your mouse on many objects in OnTraQ you will see a 
menu of options. Depending on the object you right-click on, the menu will 
contain different options. If you click on the title bar of a pane, you may get the 
following options: 

• Dock able 

• Hide 

• Floating 

• Auto Hide 

• Move to Next Tab Group/Previous Tab Group 

• New Horizontal Tab 

• New Vertical Tab 
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2.1.4.1.1. Docking Panes 

If you choose to Dock a pane, that will lock the pane in an open position 
somewhere inside the OnTraQ Tablet. If the pane was floating, you can move the 
pane with the mouse and see an indication of where it will dock when you 
release the mouse button.   

2.1.4.1.2. Hiding Panes 

If you hide a pane, that pane disappears. This option is the same as closing the 
pane.  

2.1.4.1.3. Floating Panes Outside the Tablet and Wallboard Displays 

You can float a pane outside the main OnTraQ Tablet. When you float a pane, 
you can then drag it outside the main OnTraQ display and it will then act as a 
separate window.  

This is handy for some panes, such as speedometers, histograms, and other 
data displays. You can float one or more of these outside the OnTraQ Tablet and 
then minimize the Tablet to free up desktop space on your monitor.  

Floating a pane outside the OnTraQ Tablet can be especially helpful if you want 
to display it on a Wallboard. OnTraQ supports multiple computer monitors, you 
can float a pane and make it into a separate window, and then drag it into a 
Wallboard monitor.  

2.1.4.1.4. Auto Hiding Panes 

You can Auto Hide a pane, meaning that the pane will not display when the 
mouse pointer is moved away from the pane. When a pane is Auto Hidden, you 
can view it again by hovering over the pane name displayed in the window frame.  

You can Auto Hide a pane via the right-click options, or you can also click on the 
thumbtack icon in the upper right corner of the pane to Auto Hide it. This 
thumbtack icon is a toggle, so clicking it again will turn off Auto Hide.  
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Figure 18: Service Group Status pane with Auto Hide option 

In the example above, the Service Group Status pane is Auto Hidden. You would 
hover over the title in the lower left corner to display the Service Group Status 
pane again.  

2.1.4.1.5. Closing Panes 

If you choose to close a pane, the pane disappears. This is the same as hiding 
the pane.  

2.1.4.1.6. Move to Next Tab Group/Previous Tab Group 

If you have enough panes open so that they are layered and accessible via tabs, 
you can move a pane from one tab group to the next tab group on the immediate 
right. You can also then move the pane back to the original tab group with the 
Previous Tab Group option.  

2.1.4.1.7. New Horizontal and New Vertical Tab 

If there is more than one group open in a paned display, you will have the option 
to display that group in a new horizontal or vertical pane within the pane. In other 
words, these options split the selected pane into two horizontally aligned panes 
or two vertically aligned panes, depending on your selection.   
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2.1.4.1.8. Tabbing Between Panes 

If you have multiple panes open, sometimes they are layered and you only see 
the pane on the top layer. The lower layered panes will each have a tab that 
allows you to access the pane. Simply click the tab to bring that pane to the top 
layer.  

 

   Figure: 19: Tabbing Between Panes 

If there are enough panes open, you will be able to access tabs for panes you 
cannot see via arrow buttons that scroll the display of tabs left and right.  

2.1.4.1.9. Dragging and Dropping Objects 

On many of the OnTraQ panes there are data objects you can move by dragging 
and dropping them. For example, you can change the order of report columns by 
dragging and dropping them to rearrange the report.  

2.2. Explorers 
The upper left corner of the OnTraQ tablet is reserved for OnTraQ’s Explorers.  
The Explorers are designed to work just like the Windows Explorer you are 
familiar with. They list objects in a tree format, and you can select the objects you 
want to view. When you open explorers, an asterisk will appear next to the 
opened object until you close it.   

There are two explorers you can access from the OnTraQ View menu, Service 
Groups Explorer and Agent Team Explorer. Once you have displayed these 
explorers, you can toggle between them using tabs in the explorer pane.  

To search either explorer tree, type the text in the box in the Explorer toolbar that 
you wish to search for in the tree and hit the arrow ( ).  The first occurrence of 
the text will be highlighted in the tree.  Repeated hits of the arrow will continue to 
find the next occurrence until the last occurrence is highlighted. The search is not 
case sensitive.  

2.2.1. Service Groups 
Route Control Groups for Unify and Selection Groups for Cisco are imported 
from the switch and displayed as Service Groups in OnTraQ. You are not limited 
to groups you import from the switch, however. You can create Service Group 
Pools, which allow you to group two or more Service Groups together.  

You can right-click on a Service Group and see a Properties window for it.  



 ONTR AQ US E R  GUI DE   

MAR CH  2017  IM P AC T  TE CH N O L OG I ES ,  I N C.  28 

 
Figure 20: Service Group Properties window 

This Properties window displays information about the Service Group as it is 
defined on the switch. You can edit the name only.  

2.2.1.1. Creating Virtual Groups 
OnTraQ allows you to organize your Service Groups into Service Group Pools. 
For example, you might have a dozen Service Groups total, with four dedicated 
to sales, six dedicated to customer service, and two dedicated to administrative 
use. You could create a Service Group Pool named Sales and include all the 
Service Groups dedicated to sales, and then do the same with a Customer 
Service Service Group Pool and an Administrative Service Group Pool.   

You organize your Service Groups with Service Group Explorer, a pane on the 
OnTraQ window. Below is an example. The All Service Groups tree has been 
expanded, and beneath that tree are user-created Service Group Pools.  

 

Figure 21: Service Groups Explorer 
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To create a Service Group Pool, right-click in the Service Groups Explorer pane 
and select the “Create Service Group Pool” option. A new Service Group Pool 
will be created. You can also click on the Service Group icon in the upper left 
corner of the explorer to create a new Service Group.  

 

Figure 22: Newly created Service Group Pool 

Type the name of the new Service Group Pool to replace the default text that is 
highlighted. After you type the new name, the Add Service Groups and Sub-
Pools window will display. 

 

Figure 23: Add Service Groups and Sub-Pools window 

To add Service Groups to your new Service Group Pool, find the groups in the 
Service Groups Explorer tree and drag and drop them onto the new group. You 
may have to expand some Service Group Pools to find the groups you want.  

You can also drag and drop existing Service Group Pools onto the new pool as a 
quick way of adding multiple Service Groups.  

You can also create Service Group Pools that are comprised of Service Groups 
from different telephone switches. These “cross-switch” Pools can only be used 
in historical reports and not in real-time displays. 

2.2.1.2. Properties 
You can edit Service Group Pools. By Right-clicking on the Service Group Pool 
name you will get a menu of options.  
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Figure 24: Modifying Service Group Pools 

Many of these options are associated with viewing data for the Service Group 
Pool. The options that let you modify the Service Group Pool include Alarm 
Thresholds, Remove Service Group Pool, and Properties.  

The Alarm Thresholds option is discussed later in this document.  

Remove Pool lets you delete the Service Group Pool.  

Properties displays the Service Group Pool Properties window. If you are 
displaying Properties for a newly created Service Group, you will receive some 
instructions for adding new members to the Service Group Pool.   

 

Figure 25: Service Group Pool Properties 

Use this window to change the Service Group Pool name and to either restrict 
access to it or make it viewable by all OnTraQ users. Select You to restrict 
access or Everyone to make it viewable by all. Note that the Accessible By fields 
only display for Service Group Pools you have created.    

2.2.2. Agent Teams 
OnTraQ imports ACD Group information from your switch to get the Agent 
information it displays. OnTraQ will then display the ACD Group information in 
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the form of individual Agent Teams, where an Agent Team corresponds to an 
ACD Group on the switch.  

You can organize this Agent information into Agent Groups, much like how you 
organize Route Control Groups into Service Group Pools. The following is an 
example of the Agent Teams Explorer pane displaying Agent Teams and Agents.  

 
Figure 26: Agent Teams Explorer 

You can see examples of user created Agent Teams, such as Sales and 
Customer Service (expanded). You can organize your agents however you want, 
and agents can belong to multiple teams. For example, you might have some 
newly hired agents handling sales calls. You can have these agents in both the 
Sales Agent Team and create a new team called Sales New Agents and place 
them in this new team to more quickly view their performance.  

Note that when an agent is logged in, the agent entry in the tree will be in blue 
font and include the extension number in parenthesis after the name/ID.  In 
example above, Meg is logged into extension x3582. 

2.2.2.1. Adding Names to Agent IDs 
When your agent information is imported from the switch, it does not include the 
names of the agents since this information isn’t stored on the switch. You see the 
ID number.  

You can add names to these ID numbers so that you can more easily understand 
the agent information that is being displayed in OnTraQ. You may find it easier to 
understand that ID: 1421 is also an agent named Dresch for example.  
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We recommend that your center adopt a naming convention so that all your 
OnTraQ users will apply similar conventions when renaming Agent IDs.  

2.2.2.1.1. How to Edit an Agent Name 

To rename an agent, find the agent ID on the Agent Teams Explorer tree and 
right-click on the ID. A list of options displays.  

Select the Properties option. The Agent Properties window displays. 

 

Figure 27: Agent Properties window 

You can view the agent status on this window, but you can also rename the 
agent by entering an Agent Name.  

Type a new name in the Agent Name field. Please note that while you can retain 
the ID number, you must delete the colon. You cannot use colons in the Agent 
Name field (even though by default one is displayed since this is how the 
information is imported from the switch).  

For example, if agent 1423 is named Paajarvi, you could delete the current Agent 
Name… 

 ID: 1422  

…and enter the new Agent Alias as follows: 

1423 Paajarvi 

Thereafter on the Agent Teams Explorer tree, agent 1423 will display as 1423 
Paajarvi.  

2.2.2.2. Creating Virtual Teams 
To create a new Agent Team, right-click in the Agent Teams Explorer pane and 
select the Create New Team option. A new Agent Team will be created and 
display in the Agent Teams Explorer tree.  

 

Figure 28: Creating a new Agent Team 
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Type the name of the new Agent Team to replace the default text that is 
highlighted. After you type the new name, the Add Agents and Sub-Teams 
window will be displayed. 

 

 Figure 29: Add Agents and Sub-Teams 

To add Agents to your new Agent Team, find the agents in the Agent Teams 
Explorer tree and drag and drop them onto the new team. You may have to 
expand some Agent Teams to find the agents you want.  

You can also drag and drop existing Agent Teams onto the new team as a quick 
way of adding multiple Agent Teams to the new team.  

You can also create Agent Teams that are comprised of Agents from different 
telephone switches. These “cross-switch” Teams can only be used in historical 
reports and not in real-time displays. 

2.2.2.3. Properties 
You can edit Agent Teams by right-clicking on the Agent Team name to get a 
menu of options.  

 

Figure 30: Modifying Agent Teams 

The options that allow you to modify the selected team are; Remove Team and 
Properties. 

Remove Team deletes the team. Note that the team is deleted, but the agents 
are not.  
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Properties allows you to edit the Team Name and to change the Team Type. 
There are three Team Types, ACD Group, IVR Farm, and Multi Agent User. 
Since agent information is imported from the switch, only groups defined on the 
switch as ACD Groups and IVR Farms will appear as that team type in OnTraQ. 
You cannot create a new Agent Team and designate it as an ACD Group or IVR 
Farm. Likewise, since Multi Agent User teams are specific to OnTraQ, only new 
teams you create within OnTraQ can receive this designation.  

You can also use the Agent Team Properties window to either restrict access to 
this team or make it viewable by all OnTraQ users.  

ACD Groups are simply agents that belong to the same ACD Group. IVR Farm 
are for the Agent IDs that correspond to your automated answering systems. 
There are fewer call states associated with IVR Teams.  

 

Figure 31: Agent Team Properties for a standard Team 

Note that you can see the OnTraQ server name on this display.  

Multi Agent Users are a special Team Type that help you keep track of agents 
who tend to float from group to group. 

2.2.2.4. Defining Multi-User (Floater) Agents 
You can also create an Agent Team that contains agents who float from group to 
group on an as-needed basis, if your organization supports that kind of agent 
activity.  

Create a team for an individual floater agent. Let’s call him Magnus. You create a 
Magnus Team, designate it as a Multi-User team in Properties, and then you can 
assign Magnus’ different Agent IDs to this team. In other words, if Magnus floats 
from Sales to Customer Service to Technical Support and has a unique Agent ID 
for each group you can save yourself time trying to find him. You can do this by 
putting each of Magnus’ Agent IDs into his Magnus Team, and then you can 
simply look at the Magnus Team and see what group he is currently working in. 
It’s easier than looking for Magnus in the Customer Service team, then the Tech 
Support team, and finally finding Magnus in the Sales team. 
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Figure 32: Agent Team, Floaters 

2.3. Creating Cross-Switch Pools and Teams 
You can also create Service Group Pools and Agent Teams that are comprised 
of Service Groups and Agents from multiple switches. The data you can see for 
these cross-switch Pools and Teams is only historical data, however, and won’t 
be available until the next day after you create a new cross-switch object.  

To create a cross-switch Pool or Team, you first need to log into both of the 
switches you want to draw from. Your switches are listed under the File menu. 
The current switch you are logged into will be displayed with a checkmark. 
Simply select the second switch and you will be logged into it as well, and then 
the Agent and Service Group selection trees will display objects from both 
switches.  

Next, create a new Pool or Team. The following window will display: 

 

Figure 33: The Select OnTraQ Server window 

Use the drop-down list and select the Enterprise (All Servers) option, and this 
allows you to populate your new Pool or Team with objects from all the switches 
you are currently logged into.  

The Properties window for the new Pool or Team you create will display the 
server name as Enterprise (All Servers). You can also define this Pool or Team 
to be accessible to everyone or only to you.  
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Figure 34: The Properties window for an Enterprise (All Servers) Pool or Team 

Note that cross-switch Pools and Teams can only be used to display historical 
data, and that data only becomes available the day following the creation of the 
Pool or Team.  

2.4. Defining Alarm Thresholds 
You can define Alarm Thresholds for Service Groups, Agent Teams, and 
individual agents. Alarm Thresholds allow you to define the color in which data 
displays and the alarm sound used to indicate an alarm. The colors and sounds 
each indicate a different alarm state.  

If an entity – that is, a Service Group, Agent Team, or agent – doesn’t have 
Alarm Thresholds defined, it will inherit the Alarm Thresholds defined for a parent 
entity.  

For example, you can have several Service Groups associated with sales 
activities all grouped under a Sales Service Group Pool. You could define Alarm 
Thresholds for each of these Service Groups, or you could leave the definitions 
blank and define Alarm Thresholds for the Sales Service Group Pool. All the 
Service Groups under the Sales Service Group Pool would then inherit its Alarm 
Threshold definition.  

Once an entity’s Alarm Thresholds are defined, those definitions will be static and 
will not change even if the entity is moved to a different group with different Alarm 
Thresholds. For example, if an agent belongs to Agent Team A and inherited 
Alarm Thresholds from that group, that agent’s definitions will remain in place if 
the agent is moved to Agent Team B. You will have to manually change those 
definitions.  

(Service Groups cannot have their own definitions and still inherit parent 
definitions. You need to remove definitions if you want them to inherit definitions 
from a parent entity.) 
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2.4.1. Service Group Alarm Thresholds 
Select the Tools – Alarm Thresholds option. The Alarm Thresholds window 
displays. Make sure the Service Group Pool tab is selected. 

 

Figure 35: Alarm Thresholds, Service Groups 

To have the Alarm Thresholds be identical to another group’s settings, select the 
group you wish to copy with the Inherit From drop-down list. The Alarm 
Thresholds settings from that group will be copied to this window and you will see 
them displayed in pink, to indicate that they are inherited settings. To have the 
settings inherited, click on the Set Pool Members to Inherit these Settings button.  

You can define the Service Level and the Service Group Thresholds on the 
Service Group Pool tab. (The drop-down list shows the current Service Group. 
You can select a different Service Group with this list if you desire. This is just a 
quick way of changing groups you wish to edit.) 

Under Quality Measurements, set the following options:  
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• The Service Level is the maximum time in which you want calls to stay in 
queue before being answered. It drives the % Answered within Service 
Level real-time Service Group Answer Performance metrics.  

• Check the “Use Caller Experience for Service Level” box to have the “% 
Calls Answered within Service Level” and “Average Time in Queue” 
columns in the Service Level section of the Service Group reports 
calculated based on the total time elapsed since the call entered the 
ACD system (caller experience), as a call potentially passes through 
multiple queues before being answered. If unchecked, the columns are 
calculated based only on the time the call was in the queue that the call 
is answered from.  Note this setting is applicable per Service Group.   

• Minimum Queue Abandon option sets the minimum duration a customer 
must wait in queue before being counted as an abandoned call.  For 
instance, if set to 3 seconds and caller hangs up after two seconds, the 
call will not be assigned as an “abandon queue” call but as a “hang up.”  

The Service Group Thresholds consist of three time bands; Low, Medium, and 
High. These correspond to the alarm states you want to monitor. You can define 
Thresholds for… 

• # Calls in Queue – the number of calls waiting to be answered 

• Average Queue Time – the average time a call waits in queue before 
being answered 

• Oldest Call In Queue – the oldest call still waiting to be answered 

• % Ans w/in Service Level – the percentage of calls answered before the 
service level threshold is reached 

• # Agents Logged In – the number of agents logged into the ACD 

• # Agents Idle – the number of agents ready to answer a call but not 
currently working on a call 

• Talk Time – the amount of time spent talking on a call  

• Work Time – the amount of time spent in after call work (Note:  If custom 
work states are defined there will be an entry for “All Work Time” and 
then individual entries for all custom states.)  

2.4.2. Agent Team Alarm Thresholds 
You can define different Alarm Thresholds for different Agent Teams. For 
example, you might want all calls to your Sales Team to be answered more 
quickly than calls to your Customer Service Team. You can define different Alarm 
Thresholds for each team to support this.   

To set Agent Team Alarm Thresholds, select the Tools – Alarm Thresholds 
option. The Alarm Thresholds window displays. Make sure the Agent Teams tab 
is selected. 
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Figure 36: Alarm Thresholds, Agent Teams 

To have the Alarm Thresholds be identical to another group’s settings, select the 
group you wish to copy with the Inherit From drop-down list. The Alarm 
Thresholds settings from that group will be copied to this window and you will see 
them displayed in pink, to indicate that they are inherited settings. To have the 
settings inherited, click on the Set Pool Members to Inherit these Settings button. 

You can define the Agent State Thresholds on the Agent Teams tab. (The drop-
down list shows the current Agent or Agent Team. You can select a different 
Agent or Agent Team with this list if you desire. This is just a quick way of 
changing Agents or Agent Teams you wish to edit.) 

The Agent State Thresholds consist of three time bands, Low, Medium, and 
High. These correspond to the alarm states you want to monitor. You can define 
Thresholds for… 

• Idle – the time an agent is ready to answer calls but not active on a call 

• Non-ACD – the time in which an agent spends on Non-ACD calls 

• Other – the time spent in the other state 

• Unavailable – the time in which an agent is in the unavailable state.  
(Note:  If custom unavailable states are defined there will be an entry for 
“All Unavailable Time” and then individual entries for all custom states.) 
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Another option, Set Team Members to Inherit these Settings, allows you to 
override any individual Alarm Threshold settings you may have defined for 
agents in this selected group.  

2.4.3. Changing Alarm Colors and Sounds 
The Alarm Colors and Sounds are defined system-wide for OnTraQ. In other 
words, you cannot define different Alarm Colors and Sounds for different OnTraQ 
users. Normally, these are defined by your OnTraQ administrator. For more 
information on defining alarms, see 1.3.5 Alarm Colors and Sounds. 

2.5. Status Displays 
OnTraQ can display dynamic information that captures what is happening in your 
center at any given moment through its status displays.  

You can display Agent Team Status and Service Group Status for each Agent 
Team and Service Group you have defined. Further, you can have more than 
one Status displayed at a time. For example, you could have five Agent Teams 
displayed and three Service Groups displayed.  

 

Figure 37: Status displays in OnTraQ 

In the example above, several Agent Status displays for different Agent Teams 
are displayed in the top half of the OnTraQ Tablet, and the Service Group Status 
is displayed in the lower half of the Tablet.  
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2.5.1. Service Group Status 
To view the Service Group Status pane, go to Windows – Service Group Status. 
This displays a pane for Service Groups and Service Group Pools. (The default 
is to display the Service Group Status pane, but if it’s closed for any reason, you 
can redisplay it.) 

The Service Group Pool will show totals for all the Service Groups that belong to 
the Service Group Pool. You can also see those Service Groups displayed 
individually in the Status Display as well.  

 

Figure 38: Detail from the Service Groups status display 

The data that is displayed represents the Alarm Color states your OnTraQ 
administrator defined. Like other Panes in OnTraQ, you can hide, auto hide, float, 
and dock the Service Group Status Display.  

There are three metrics for Service Group Status you can view. These are 
discussed below.  

2.5.1.1. Metrics 
The three metrics you can view are Answer Performance, Queue Status, and 
Agent Status. These are displayed in the Service Group Status Display. You can 
choose to hide any of these by right-clicking on either the metric itself or the 
labeled Service Group area on the left side of the Service Group Status Display.  

 

Figure 39: Selecting the information you want to view 

You can also use this right-click menu to redisplay a metric you have hidden.  



 ONTR AQ US E R  GUI DE   

MAR CH  2017  IM P AC T  TE CH N O L OG I ES ,  I N C.  42 

When you click on the Service Group column header located on the left side of 
the Service Group Status display, a small arrow appears to the right of the 
“Service Group” text. Use this arrow to reorder the Service Group display. Click 
on it to reverse the order. Click again to revert back to the original order. This 
option works for all columns in the display.  

You can also right-click on the title bar of each metric and choose to hide or 
redisplay individual metrics. For example, in the Agent Status metric you can 
right-click and choose to hide the Idle column. In the Answer Performance metric 
you can choose to hide all of the Average Queue Time data. To redisplay 
something you have hidden, right-click in the appropriate area and you will get a 
menu of items you can hide and redisplay.  

 
Figure 40: Hiding columns 

2.5.1.1.1. Answer Performance 

The Answer Performance metric defaults to display the percentage of calls 
answered within the defined service level and the average queue time for calls 
for each data interval, as shown below. Additional available metrics include 
average answer time and the number of calls abandoned. The data intervals are 
Quarter Hour, Hour, Session and Day, with Session hidden as default.  

 

Figure 41: Answer Performance detail 

The service level target for the percentage of calls answered is defined in System 
Preferences.  

To display the additional metrics of average answer time and abandons, right-
click on the Answer Performance heading and click the metric you want to add to 
the display. 
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Figure 41B:  Answer Performance Additional Metrics 

2.5.1.1.2. Queue Status 

The Queue Status metric displays the current calls in queue and segments them 
by the time bands your OnTraQ administrator defined for your organization. You 
will also see the total number of calls in queue as well as the length of time the 
oldest call in queue has been waiting.  

You can right-click anywhere in the Queue Status display to get an option to hide 
the entire Queue Status display.  

 

Figure 42: Queue Status detail 

2.5.1.1.3. Agent Status 

The Agent Status metric displays the work state the Service Group’s agents are 
currently in. The colors for the work states do not correspond to the Alarm 
Colors.  

You can see the total number of agents logged in and how many are in the 
following work states: 

• Talk – handling an ACD call 

• Work – in after-call work 

• Idle – waiting to receive an ACD call 

• Non-ACD – on a Non-ACD call 

• Other – in the other work state 
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• Unavailable – not available to handle a call 

 

Figure 43: Agent Status detail 

2.5.1.2. Graphical Displays 
There are two kinds of graphical displays in OnTraQ, Histograms and 
Speedometers. Histograms can be single-state or multi-state. Histograms and 
Speedometers are explained below.  

Single-State Histograms will display the selected data item color-coded with the 
appropriate Alarm Color to represent the alarm state it is in.  

Multi-State Histograms display agents and the work states they are in.  

Speedometers are like Single-State Histograms. They display the same data in a 
different format, and if Alarm Colors are applicable for the data item, those are 
displayed as well.   

To display a Histogram or Speedometer, right-click on the data object you want 
displayed. You will see a menu that lets you choose the kind of display you want.  

 

Figure 443: Right-Click menu for displaying a graph 

These graph types are discussed in greater detail below.  

2.5.1.2.1. Histograms 

Histograms can be displayed as column graphs or area graphs. After displaying 
a Histogram, click on the Options button to display the available graphing 
options. You can select the Interval, Range, and Chart Type.  
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Figure 45: A Histogram with data displayed in columns 

The Interval will let you select the data frequency that is graphed on the X axis – 
in other words, what each column or area represents in terms of time. If you 
select 10 Seconds as the interval, for example, then each bar or column 
represents 10 seconds worth of data.  

Range indicates the time range displayed in the graph. For example, if you select 
15 minutes, the entire display will show the most recent 15 minutes of data.  

Chart Type lets you select either a Column or Area display.  

The colors displayed in the graph indicate the alarm state of t he object being 
graphed. This is valid only for a normal Histogram. Multi-State Histograms do not 
show alarm colors.  

 

Figure 46: A Histogram with data displayed as an area 

You can also format the Y Axis information in the chart. To do this, right-click 
anywhere inside the graph to access the Format Y Axis window.  
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Figure 47: Format Y Axis window 

This window allows you to set the scale of the Y axis, choose either percent or 
decimal places for the labels, and hide or display vertical gridlines in the 
histogram.  

2.5.1.2.2. Multi-State Histogram 

You can elect to display a Multi-State Histogram instead of a regular Histogram. 
Instead of showing data for one object, a Multi-State Histogram graphs the states 
for that object. If the object you are graphing is Agent Status, those states will 
display in the Histogram with a color that corresponds to the Agent Status display 
within the Server Group Status pane.  

 

Figure 48: A Multi-State Histogram display 

The options for Multi-State Histograms are the same as the ones described in the 
previous section on regular histograms.    

2.5.1.2.3. Speedometers 

You can choose to display performance information from the Service Group 
Status Pane in the form of a speedometer. This gives you an “at-a-glance” 
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format.  To display information, right-click on the data field for which you want to 
see the information graphed in the Speedometer format.  

 

Figure 49: Selecting the Speedometer option 

After you right-click and select the Speedometer option, the Speedometer Pane 
will be displayed. You may want to use the Float option to reduce the size of the 
speedometer display.  

 

Figure 50: A Speedometer display 

You can use the Options button to access parameters that set the scale for the 
Speedometer. The various colors on the arc below the numbered scale represent 
the Alarm Thresholds.  

You can also create more than one Speedometer. In this way, you can monitor 
multiple data items quickly. You can, for example, create several Speedometers, 
float them outside the OnTraQ Tablet, and then minimize the Tablet.  

2.5.2. Agent Status 
When you choose to view Agent Team Displays, you can view a display for 
Agent Teams and Agents. These displays will be arranged via tabs on the Tablet 
to make for easy switching between the teams and agents you wish to view.  
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Figure 51: Agent Teams and Agent displays 

You can view agent status by agent states, so that each agent is displayed in a 
column representing the state that the agent is currently in. To view this, right-
click on an Agent Team in the Agent Team Explorer and select Display Agent 
Status to see the status of all agents in the Agent Team.  

Each column also displays the time that the agent has been in the current state. 
You can order the display of agents in each state by longest or shortest amount 
of time in that state by clicking on the arrow to the right of the Time label.  

Note: An Agent ID may appear in a different color font if their status is currently in 
an alarm state (e.g. in an idle state for more than 60 minutes). An Agent ID that is 
highlighted gray indicates the agent is currently using their second phone line. 

 

Figure 52: Detail from the Agent Display 

Agent state columns, as well as the columns within each state, can be hidden 
and unhidden, depending on what you are interested in viewing. Simply right-
click the header of an agent state column and options will be displayed. For 
example, if you right-click the Non-ACD header, you have the ability to hide the 
entire Non-ACD column, or you may hide just the Agent, Type, Phone Number 
and/or Time columns. Columns that are not currently hidden will have 
checkmarks next to them, while columns that are hidden will not. You may also 
hide and unhide columns within a state (e.g. Agent, Type, Phone Number, Time) 
by right-clicking the headers of these columns and selecting what you want 
hidden or not hidden. 
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 Figure 53: Detail from the Agent Display  

Notice that agent states that are currently hidden are shown at the bottom of the 
right-click menu in the Hidden States section. To unhide one of these hidden 
states, simple select it from this menu. 

Note: If a window layout with the Agent Team Display has been saved, any 
columns that are hidden will remain hidden upon logging out and logging back in 
to OnTraQ. Alternately, if a logged-in user closes the Agent Team Display and 
then reopens it, it will always be opened in the default view, which includes all 
agent state columns. However, any time a user logs in to OnTraQ, the Agent 
Team Display will still be formatted as it was for the saved window layout (with 
hidden columns, etc.). 

2.6. Agent State 
OnTraQ allows users to view and modify individual agent’s states, in addition to 
being able to view multiple agents’ statuses simultaneously. To view individual 
agent states, right-click on an agent in the Agent Team Explorer and select 
Modify Agent State. When you display an agent state individually, you see the 
agent’s current state, and you can also change their state from this window. 

 
Figure 54: Modify Agent State display 

2.6.1. Modifying Agent State 
Once you have accessed an Agent State display, you can view a real-time 
display of the agent’s current Extension, State, Time in State and Service Group.  
You also have the ability to change the agent’s current state by selecting the 
desired new state from the State dropdown in the Change To section of this 
window. Default states for agents currently logged on to their phones include 
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Logoff, Idle, Unavailable and Work. (Note that the Administrator may define 
additional Work and Unavailable states. See section 1.5 for more details.) 

After you have selected the State to change an agent to, press Apply for the 
change to take effect. If the agent is in a non-call state, you will instantly see the 
change reflected in the Current fields in the top half of the Agent State window. If 
the agent is in a call state, the changes will take effect as soon as the call has 
ended. 

Agents that are offline may be logged on through this window as well. To log an 
agent on to their phone, simply display their Agent State window and select 
Logon from the Change To State dropdown. Click Apply for the change to take 
effect. 

Note: If you try to logon an invalid extension or one that exists but has no phone 
plugged in, an error message will appear in the Change To section of the Agent 
State display shortly after you click Apply. 

2.7. Activity Log 

2.7.1. Agent Activity Log 
The Agent Activity Log displays information about the selected agent’s work 
status. You can choose to display either current or historical data for three 
different categories of activities, Agent States, System Events, and Alarm 
Thresholds. Right-click on an Agent ID (or name if you have renamed IDs) in 
Agent Explorer to select the Agent Activity Log option.  

• 2nd Line Events – any event that utilized an agent’s second line during 
the selected time period. 

• Agent States – the history of the states the agent was in for the selected 
time period. 

• Alarms – any alarm thresholds that were breached during the selected 
time period.  

• System Events – any system events that were recorded during the 
selected time period.  

 

Figure 55: Agent Activity categories 

Please note that the Activity Log uses the time zone information pertaining to the 
switch that hosts the Agent Group to determine the time ranges for the last 
quarter hour, hour, and current session.  



 ONTR AQ US E R  GUI DE   

MAR CH  2017  IM P AC T  TE CH N O L OG I ES ,  I N C.  51 

2.7.1.1. Using the Agent Activity Log 
To display information in the Agent Activity Log, you must select the Detail, 
Category, and Activity for which you want to display information. These are all 
drop-down menus that filter the information that will be displayed in the report. 
Note: You can print any of these displays or export them to Excel using the Print 
and Export buttons in the upper left corner of the Activity Log pane, respectively. 

For the Detail drop-down menu, your choices are Qtr Hour, Hour, Session, Full 
Day, and Pick Date (to see historical data). The data interval you select will then 
display with a rolling total that is updated in real-time, unless you selected Pick 
Date.   

(To see historical data, select the Pick Date option to display a calendar and then 
select the past date for which you want to view Historical data.)  

For the Category drop-down menu, you select the type of information you want to 
display -- Agent States, Alarm States, System Events, and All Categories. All 
Categories will include information from each of the categories in the report.  

For the Activity drop-down menu, you can select one activity or All Activities. 
Available activities are based on the Category selection. For example, if you 
selected Alarm Thresholds in the Category drop-down, your Activity drop-down 
selections will be based on alarm thresholds. If you select All Categories in the 
Category drop-down, then the Activity drop-down will display all the activities 
associated with the three categories.  

Once you have data displayed, the following data items are included in the 
report:   

• Activity – the activities the agents performed as recorded by the ACD.  

• Service Group – the service group that the call was routed through 
before being answered by the agent.   

• Alarm – any alarm conditions that occurred.  

• Up Arrow/Down Arrow column (to the right of the Alarm column) – this 
column will show whether the alarm condition is trending upwards or 
downwards. 

• Time Elapsed – the total time in each state.  

• Start Time – the time the agent entered a state.  

• End Time – the time the agent left the state.  
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Figure 56: Agent Activity Log 

Note that there’s also a column of icons to the far left of the display. These icons 
correspond to the activity state.  

You can hide or display any of the columns by right-clicking on a column heading 
to see a list of available columns. Uncheck or check a column name to hide it or 
display it.  

You can also display a Life of Call report for any object in the Activity Log report. 
Right-click on the object to access an option to display the Life of Call report.  

2.7.1.2. Agent Activity Log: 2nd Line Events 
2nd Line Events will report on the following data items: 

• 2nd Line Call In – displays when an agent is handling an incoming call to 
their second line. 

• 2nd Line Call Out – displays when an agent makes an outgoing call from 
their second line. 

• 2nd Line Talk – displays the time spent by an agent on a second line call. 

2.7.1.3. Agent Activity Log: Agent States 
Agent States will report on the following data items: 

• Idle – displays when an agent is available to take a call but not currently 
on a call.  

• Logged In – displays the start and end times for the agent being logged 
in, and the total duration of the login time. 
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• Logged Out - displays the time the agent logged out.  

• NonACD Call In – displays when an agent is handling an incoming 
NonACD call.  

• NonACD Call Out – displays when an agent is making an outgoing 
NonACD call. 

• Other – displays the off hook time for an agent. 

• Talk – displays the seconds spent on the call by this agent. 

• Unavailable – displays the time spent in the unavailable state by the 
agent. 

• Work – displays the time spent in the work state by the agent. 

2.7.1.4. Agent Activity Log: Alarms 
Alarms will report on the following data items: 

• Idle Time – the alarm threshold state of an agent’s time waiting for a call. 

• Non-ACD Call Time – the alarm threshold state of an agent’s time spent 
on Non-ACD Calls. 

• Other Time – the alarm threshold state of an agent’s time spent in the 
Other state. 

• Talk Time – the alarm threshold state of an agent’s time spent in the Talk 
Time state. 

• Unavailable Time – the alarm threshold state of an agent’s time spent in 
the Unavailable state. 

• Work Time – the alarm threshold state of an agent’s time spent in the 
Work Time state. 

2.7.1.5. Agent Activity Log: System Events 
System Events reports on switch- and server-related OnTraQ activity and will 
report on the following data items: 

• Connected to Switch – the time OnTraQ has spent connected to the 
switch.  

• Data Stream Started – the time at which OnTraQ began receiving data 
from the switch. 

• Data Stream Stopped – the time at which OnTraQ stopped receiving 
data from the switch. 
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• Lost Switch Connection – the time at which OnTraQ may have lost its 
connection to the switch. 

• OnTraQ Server Started – the time at which the OnTraQ server was 
started.  

2.7.2. Service Group Activity Log 
The Service Group Activity Log displays information about the selected service 
group status. You can choose to display either current or historical data for 
System Events and and Alarm Thresholds. Right-click on the Service Group 
name in Service Group Explorer to select the Service Group Activity Log option 

 

 Figure 57: Service Group Activity Log  

2.8. Life of Call 
You can access a Life of Call report for individual agents, ACD Groups, or 
Service Groups. To see a Life of Call report, right-click on the Agent ID (or agent 
name if you have renamed Agent IDs), ACD Group name, or Service Group 
name and select the Life of Call option. You can also access a Life of Call report 
by right-clicking on an object in the Activity Log or in any current or historical 
report and selecting the Life of Call option. This will display a Life of Call report 
for the selected object.  

 

Figure 58 Detail from Reports Window for Life of Call report option 

The Life of Call report displays a chronology of the call activity. It presents a 
“snapshot” of the call as captured whenever the user chooses to display the Life 
of Call report. You select the Date, Start Time, and End Time for which you want 
to view Life of Call information, and then click on the Go button to display the 
information.   
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The Life of Call report is segmented into call states for the call being tracked. 
Each call has a summary row in the report and this is all that initially displays, but 
this summary row can be expanded via the control button to the left of the 
summary row to show the various call states that the call experienced.  

Please note that the call state displayed in the summary row is the final call state 
that the call experienced. If you expand the summary row to show all the call 
states for the call, remember that the summary row does not display the initial 
call state but displays the final call state.  

 

Figure 49: Life of Call 

The data fields associated with the call you see in this report are:  

• Start – when the call state began 

• End – when the call state ended 

• Elapsed – the total time of the call state 

• Service Group – the Service Group that the call was routed to before it 
was answered by an agent 

• Agent – the agent who handled the call 

• Activity – the different call states the call progressed through, such as 
Call in Queue, Call Ringing, Call Talking, etc. 

• Connected Party – the party associated with the Activity 

• Calling Number – the number originating the call 

• Called Number – the number dialed by the originating number 

Note: “Unknown” appears in the Calling Number and/or Connected Party fields 
when the number is unavailable. 
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To expand the Life of Call information, click on the control button to the left of the 
first column. This will show you detailed information about each activity state the 
call progressed through.  

You can filter the display to show only calls that had a selected Activity occur, 
such as all calls that were completed normally, all calls that were sent to an 
agent, etc. To filter the calls, select the Activity you want to use as the filter from 
the Activity drop-down list.  

You can also drag and drop the columns to rearrange them.  

To hide or redisplay any of the columns, right-click on a column heading to see a 
list of columns, uncheck or check a column name to hide it or redisplay it. 

To print a Life of Call display or export it to Excel, use the Print and Export 
buttons in the upper left corner of the Life of Call window, respectively. 

2.9. Transaction Code  
The Transaction Code report lets you see the number of calls for a selected date 
and time range that were assigned a transaction code by your agents when they 
handled the call.  

Before you can create a Transaction Code report, you must define within 
OnTraQ the different transaction codes. Once these codes are defined, OnTraQ 
will be able to create reports based on this information.   

To define codes, you need to go to the Tools – Transaction Codes option. The 
Transaction Codes window will display. Note that this option is reserved for 
Administrative users only. Other users will not see it as a menu option.  

 

Figure 60: Transaction Code window 
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To define a code, click on Insert New Code. A blank row for the new code will 
display.  

In the blank row, enter a code name and the digits for the code as defined on 
your switch.  

2.9.1. Transaction Codes Report 
The Transaction Codes display will display the transaction codes entered by your 
agents as they received calls for the selected date and time range. To view the 
report, right-click on an Agent Team and select the Transaction Code Report 
option from the menu that displays.  

 

Figure 61: The Transaction Code Report 

Once you display this pane, you can select the date and time range for which you 
want to see calls that were designated with transaction codes. You can also 
select the level of detail, either quarter hour, hour, day, week, or month.  

You will only see intervals that contain calls that were designated with transaction 
codes. For those intervals, you will see the date and time, the code, the name of 
the code, and the number of times that code was entered during that interval.  

You can also hide or redisplay any of the columns by right-clicking on a column 
heading and getting a list of columns. Uncheck or check a column name to hide it 
or redisplay it. 

2.10. Performance Reports 
OnTraQ lets you create Performance Reports for your Service Groups, Service 
Group Pools, Agent Teams and Agents. There’s a wide variety of data types you 
can include in these reports. For example, you can create a Performance Report 
that shows, for the Agents selected, the number of calls received, the number of 
calls unanswered, the number of calls abandoned, and the number of calls 
picked up. Those are just four of the data items you might build a report around. 
There are many more you can include, such as Total Talk Time per call, Total 
Idle Time, and so on.  
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OnTraQ provides the framework for building performance reports. You add to the 
framework by selecting the data types you want to see in the report. You might 
design one report that tracks just a few data items and another that tracks a 
dozen or more.  

You can also share your saved report templates with other OnTraQ users or 
keep them private for your own use. When you share a report template, that 
allows other users to generate reports based on that template, and it also lets 
them take your template and modify it and save it under a new report name. You 
may have some data items in your report that another user isn’t interested in 
seeing, so he or she can remove them and save the report template under a new 
name. Likewise, another user may wish to add other data items that you didn’t 
include.  

You can also share reports with others in your organization, even if they are not 
OnTraQ users. You can save the report output to an Excel spreadsheet format, 
or you can save output to OnTraQ’s own report writer format.  

You can download a version of this report viewer from Impact Technologies’ 
website (http://www.impacttech.com/ontraqsupport/) and any OnTraQ historical 
report data saved in the native OnTraQ format can then be viewed with this free 
report viewer. This report viewer is used to view historical report data exported to 
a file or e-mailed as an attachment. 

Refer to the Section 3: for more information about the data items.  

2.10.1. Current and Historical 
You can create Performance Reports that display historical data and you can 
create reports that display current data in a dynamic fashion, including rolling 
totals for hours, quarter hours, sessions, and days. Current Reports will update 
their displays in real-time to reflect changing data.  

Further, you can create current and historical reports for Service Groups, Service 
Group Pools, Agent Teams, and Agents.  

To create a report, just right-click on the object (the group, team, or agent) you 
want to include in the report. See the following example: 

http://www.impacttech.com/ontraqsupport/
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Figure 62: The Current Performance Report option for an Agent Team 

In this example, the user is selecting a Current Performance Report for the Agent 
Team All Teams. The user has selected a Shared Report, meaning a report 
format that an OnTraQ user has previously defined and shared with all users. 
The name of the report the user is selecting is Calls.  

Note: You can also access a Life of Call report from any current or historical 
report. Right-click on the object to access an option to display the Life of Call 
report.  

2.10.1.1. A Note About Historical Reports and Day Totals 
Please note that any historical reports with day totals must be scheduled for 30 
minutes after the end of day time setting in Traffic Analyst or else the day totals 
won’t be accurate. Normally, this setting in Traffic Analyst is the default switch 
setting for the end of day time, which is 2:30 AM for the OpenScape/HiPath 4000 
or Cisco UCM. Traffic Analyst users can change the end of day time in Traffic 
Analyst, however. 

2.10.2. Service Groups and Agent Teams  
You can choose to create and display reports for your Service Groups, and 
Service Group Pools, and Agents, and Agent Teams.  

Right-Click on the object you want to generate a report for, either a Service 
Group or Service Group Pool in the Service Groups Explorer, or the Agent name 
or Agent Team name in the Agent Teams Explorer.  

After right-clicking, select either Current Performance or Historical Performance 
to see either a current dynamic display that updates in real-time, or a historical 
display of past data. Under either Current or Historical you will see the default 
reports and any user-defined reports that are available for all users to view.  
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You can also choose to design a new report for either Current or Historical by 
selecting the New Current Report or New Historical Report options.  

2.10.2.1. Report Options 
Report Options are the building blocks of Service Group and Agent Team 
Performance Reports.  

 

Figure 63: Detail from Report Criteria 

The following criteria are available when you create new Service Group or Agent 
Team Performance Reports:  

• Date Selection (for Historical Reports only) 

• Time Periods (for Historical Reports only) 

• Report Detail 

• Service Groups (Agent only) 

• ANI/DNIS (Service Group only) 

• Data Groups 

• Formatting 

• Save As and Available To 

These are explained in detail in the following sections.  

2.10.2.1.1. Date Selection 

Date Selection allows you to choose the date range for displaying a Historical 
Performance Report.  

 

Figure 64: Date Selection for reports 
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You can select: 

• All Available – all available historical data for the selected Agent Team or 
Service Group. 

• Current – the current day. 

• Last X number of Y – where X is number of units and Y is the type of 
unit, days, weeks, or months. Weeks are Sunday through Saturday and 
days are midnight to midnight. Note that you cannot change these 
Sunday through Saturday and midnight to midnight range designations.   

• Start and End – a beginning and ending date range. Selecting this option 
will display a calendar that allows you to select the date range.   

2.10.2.1.2. Time Periods 

Time Periods lets you select the time range for the Performance Report.  

 

Figure 65: Time Periods for reports 

You can select: 

• Days – All days, Primary days, or Non-Primary days 

• Hours - All hours, Primary hours, or Non-Primary hours 

• Start and End – a beginning and ending time range in the HH:MM:SS 
AM/PM format 

Note that Primary days and hours are defined in Traffic Analyst.  

2.10.2.1.3. Report Detail 

Report Detail lets you select the granularity of data displayed in the Performance 
Report.  
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Figure 66: Report Detail 

You can display any or all of the following: 

• Quarter Hour  

• Hour  

• Day  

• Week or Month Totals (not both) 

You can also display information by Organization Level, choosing to display all 
levels (Max) or levels 1 through 6. The way levels work is by designating the 
object you initially select to generate the report as the parent object, and all 
objects underneath it as children objects.    

For example, if you select a Sales Agent Team as the initial object for your report 
then this becomes the parent object, or the level 1 object. Every object directly 
underneath becomes a level 2 object. Any objects beneath those become level 3 
objects, and so on. When you select Organizational Level 1, you would only see 
a report with cumulative information for the Sales Agent Team. If you selected 
Organizational Level 2, you’d see both the cumulative Sales Agent Team data 
and also cumulative data for each child object directly beneath the Sales Agent 
Team.   

Please note that any historical reports with day totals must be scheduled for 30 
minutes after the end of day time setting in Traffic Analyst or else the day totals 
won’t be accurate. Normally, this setting in Traffic Analyst is the default switch 
setting for the end of day time, which is 2:30 AM for the OpenScape/HiPath 4000 
or Cisco UCM. Traffic Analyst Administrative users can change the end of day 
time in Traffic Analyst, however. 

2.10.2.1.4. Service Groups (Agent and Agent Team Reports Only) 

The Service Groups section displays only when you are creating an Agent or 
Agent Team Performance report. This section allows you to select the Service 
Groups for which you want report information displayed.  
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Figure 67: Service Groups selection for reports 

Click on the checkbox next to the name of the group if you want to see it 
represented in the report.  

2.10.2.1.5. ANI/DNIS (Service Group Reports Only) 

The ANI/DNIS section displays only when you are creating a Service Group 
Performance report.  

This section allows you to select the ANI/DNIS for which you want report 
information displayed.  

 

Figure 58: ANI/DNIS selection 

Click on the checkbox next to the name of the ANI/DNIS if you want to see it 
represented in the report. 

2.10.2.1.6. Data Groups 

The Data Groups section lets you select the data types you want displayed in the 
report.  

 

Figure 69: Data Group selection 

Click on the checkbox next to the name of the Data Group if you want to see it 
represented in the report. Each Data Group is comprised of several individual 
Data Types. If you deselect a Data Group, all of the Data Types associated with 
that Group will no longer be displayed in the report.  
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You can also deselect individual Data Types within a group to remove them from 
the report by right-clicking on the report column with the Data Group to get a list 
of Data Types to select and deselect. See 2.10.3.1 Report Columns for more 
information.  

Note that the Data Groups available for use in a report vary by report format. For 
more information on the Data Groups refer to the Data Dictionary in Section 3.  

2.10.2.1.7. Formatting 

Formatting allows you to set the hours display in reports.  

 

 Figure 70: Formatting  

You have the following choices you can select from the drop-down list: 

• Hours/Mins/Secs (hh:mm:ss) – this shows the time for the report item in 
hours, minutes, and seconds. 

• Hours No Decimals – this shows the time in hours, with the time 
rounding up to the next hour. For example, if talk time were one hour and 
46 minutes, Hours No Decimals would display that as two hours.  

• Hours One Decimal – this shows the time in hours extended out to one 
decimal, with the time rounding up to the next decimal. For example, if 
talk time were one hour and 46 minutes, Hours One Decimal would 
display that as 1.8 hours.   

• Hours Two Decimals – this shows the time in hours extended out to two 
decimals, with the time rounding up to the last decimal. For example, if 
talk time were one hour and 46 minutes, Hours Two Decimals would 
display that as 1.76 hours. 

2.10.2.1.8. Save As and Available To 

The Save As and Available To options allow you to save a report format you 
have created and determine who else can use that format.  

You can reserve the use of the report format to yourself by selecting the You 
radio button, which means it is only usable by you, or you can make it available 
for use to anyone else by selecting the Anyone radio button.  

The advantage of limiting the use to yourself is that it will not clutter up the list of 
available report formats that others will see if the format you create isn’t of 
interest to other OnTraQ users.  
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2.10.3. Displaying the Report 
Once you have selected the Report Criteria you desire, click on the Display 
button to generate the report and display it in the Report window. The upper 
portion of the window will display the report.  

 
Figure 71: Detail from the Reports window 

Any report row with a tree control button (the plus or minus sign) next to it can be 
expanded or collapsed. You can also hide the Report Criteria by clicking on the 
Options button (also a plus or minus sign) next to the Criteria label. That will free 
up space in the window to display more of the report.   

You can also modify your report by using the Report Options. Change the 
settings you find under Options to get the custom report you need.   

2.10.3.1. Report Columns 
You can manipulate the columns in a report. You can drag and drop columns to 
rearrange the report display, and you can also choose to hide a Data Type 
column. To hide (or redisplay) a Data Type column, right-click on the section 
header to see a list of the columns; uncheck a Data Type column to hide it, and 
check a Data Type column to redisplay it.  

 
Figure 72: The column checklist for the Total Calls section of this report. 
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2.10.4. Graphing Options – Ad Hoc and Template 
You can also choose to graph the information from a historical report. Right-click 
on a data point in the report and then select the Chart Data option. This brings up 
a graph with two tabs in the Options section, Ad Hoc and Template. 

The Ad Hoc tab lets you design a report to be displayed in the graph for one-time 
use. The Template tab lets you design a report chart that will be saved and made 
available for use every time the report template to which it belongs is used.   

Within the Ad Hoc tab, there are two more tabs you can view. The Fields Chart 
tab will display information for one agent, with the ability to display multiple Data 
Fields for that agent’s performance (shown below).  

The Agent’s Chart (not shown below) will display information for multiple agents 
for one selected Data Field.  

 

Figure 73: Agent Performance Fields Chart 

The tabbed Charts let you select the following: 

• Agent/Team (Ad Hoc only) – the selected Agent or Agent Team that will 
be graphed 

• Fields – the data items that will be graphed 

• Frequency – the granularity of the graph 

• Start and End – the beginning and ending time range that will be 
graphed 

• Chart Style – Line or Area 

• Show Legend – check to show the legend to the right of the graph or 
uncheck it to enlarge the graph 
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• Y Axis and X Axis – change the font size of the labels, the time units and 
the label on the Y axis 

• Name (Template only) – enter a name for the chart you designed 

• Front Chart Displayed (Template only) – select which chart will be 
displayed by default when the charting option is selected for this report 
template, or choose to display a different chart the chart currently 
displayed. 

After you make any changes, you need to click on the Apply Chart Setting button 
to redisplay the graph with the changes reflected.  

2.10.4.1. Formatting the X Axis and the Y Axis 
You can edit the values for the X and Y axes to change the font size of the 
labels, the time units, and the label on the Y axis. Click on the X Axis or Y Axis 
buttons or right-click anywhere in the graph to access these editing options.  

 
Figure 74: The Y Axis Format options 

When you format the Y axis, you can change the title (label) of the Y axis and 
font size of the lettering of the title, the scale of the Y axis, and font size, type, 
and format of the scale enumerators on the Y axis. Type will be number, percent, 
quarter-hour, half-hour, or hour. The format will be the number of decimals used.  

The X axis format options let you change the font size of the enumerators and 
also select the kind of time and date units that will be displayed, either 12 hour 
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time or 24 hour military time, and the date in either month-year format or month-
day-year format.  

Remember, you can try different values and settings and use the Apply Chart 
Settings button to redisplay the graph with your new settings. Try different 
combinations until you find settings that give you the kind of graph you need.  

2.10.5. Saving, Exporting, and Scheduling 
When you define a report by selecting the Report Criteria, you can save your 
format for reuse.  

You can also export the report data in four formats – an Excel spreadsheet 
format (.xls, .xlsx), OnTraQ’s own report format (.otr), Adobe Acrobat format 
(.PDF), and XPS, which is Microsoft’s alternative to PDF. 

You can also choose to print your reports.  

Finally, you can also schedule reports to be generated at a later time and date.  

Please note that any historical reports with day totals must be scheduled for 30 
minutes after the end of day time setting in Traffic Analyst or else the day totals 
won’t be accurate. Normally, this setting in Traffic Analyst is the default switch 
setting for the end of day time, which is 2:30 AM for the OpenScape/HiPath 4000 
or Cisco UCM. Traffic Analyst users can change the end of day time in Traffic 
Analyst, however. 

2.10.5.1. Saving a Report Design 
To save a report design, enter a name for the report in the Save As field.  

Next, select whom you want to make this report format available to, You or 
Everyone.  

Finally, click Save to save this report format.  

 
Figure 75: Saving report formats 

2.10.5.2. Exporting Reports 
You can also export the report data in four formats – an Excel spreadsheet 
format (.xls, .xlsx), OnTraQ’s own report format (.otr), Adobe Acrobat format 
(.PDF), and XPS, which is Microsoft’s alternative to PDF. 

To export a report, right-click anywhere in the data portion of the report. Then, 
click the Export option. When you select the Export option, you are presented 
with the standard Windows file save dialog that lets you select the file name and 
location that the exported file will be saved to.  
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The OnTraQ Report Viewer is a standalone application that anyone in your 
organization is welcome to install and use. The report viewer is available at 
Impact Technologies’ website (http://www.impacttech.com/ontraqsupport/) or 
through installation from the OnTraQ CD.   

2.10.5.3. Scheduling Reports 
To schedule a report, you need to create a new scheduled activity. This new 
activity will not contain any report information. Follow these steps to create a 
report schedule.  

1. Create a new scheduled activity within OnTraQ (not the OnTraQ Report 
Viewer). If you do not have the Scheduled Activities pane open, go to 
Tools and select the Scheduled Activities option. This will display the 
Scheduled Activities pane. Right-click anywhere inside the Scheduled 
Activities pane and select the Create Scheduled Activity option. A new 
object appears with the default name of “A New Scheduled Activity”.  

2. Rename the new scheduled activity object. Once you rename, the 
following window displays with instructions for creating your scheduled 
activity. Click on OK.  

 

Figure 766: Creating a new schedule activity 

3. Find the historical report template you want to schedule and then drag it 
and drop it on the new scheduled activity you created. (If you do not 
have the Report Templates pane open, go to Tools and select the Report 
Templates option.) You will see the report template displayed 
underneath the scheduled activity.  

http://www.impacttech.com/ontraqsupport/
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4. Find the Service Group or Agent Team you want to be included in the 
report in the Service Group Explorer or Agent Team Explorer, and drag 
and drop it on the report template beneath the scheduled activity. The 
object you dropped will display beneath the report template. Note that 
only Agents or Agent Teams can be dropped onto an Agent report, and 
that only Service Groups or Service Group Pools can be dropped onto a 
Service Group report. Remember that you can also drag and drop more 
than one object onto a report. An example of two scheduled reports is 
displayed below:  

 
Figure 77: Detail from the Scheduled Activities pane 

5. Right-click on the new scheduled activity and select Properties. The 
Schedule Activity window displays. Note that a newly created scheduled 
activity will by default always be Active. Check the Inactive box if you 
wish the scheduled activity to become inactive. 

 
Figure 78: The Schedule Activity window 

6. Schedule the report. You select the time of day and day of week, or day 
of month. Note that you can select more than one day of the week or day 
of month.  

7. Select the report output. Your options are: 
- Send output to a network printer (you can select the printer as well) 
- Save output to a network file (use the default or enter the filename and 
file location) 
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- Save output as an attachment via e-mail (you enter the filename and 
the e-mail addresses the file will be sent to) 
- Send a link to the file via e-mail (you enter the filename and the file 
location, and the e-mail addresses the link will be sent to) 
 
Note that even if you are attaching the output to an e-mail, you still have 
to select a location for the report file to be saved to. Both OnTraQ and 
Traffic Analyst save the source file when generating a report.  

8. Save the schedule by clicking on Save Schedule.  

Once the report is scheduled, it becomes a recurring event. If you do not want 
the report schedule to repeat, either delete the scheduled activity once you are 
finished with it or click on the Inactive checkbox to make it inactive. An inactive 
report retains its scheduling information and can be turned back on by clearing 
the inactive checkbox. 

2.11. Custom States in Reports 
If you choose to leverage custom work and unavailable states, your Current and 
Historical reports can provide you with the actionable detail that you are looking 
for. As you create new custom states, these states automatically appear in the 
Total Time in ACD State report data group.  

When you create a new Work state, two new data items are added to the data 
group—one for an after-call Work state and one for a non-call Work state.  For 
example, if you create a new Work state called “Special Project,” then “Work – 
Special Project” and “Non-Call Work – Special Project” will both appear in the 
data group. 

Note that all custom states will figure into the total service group or agent Time in 
State for the selected state-type. In the following example, the four columns on 
the right show the agent was on Break for 45 seconds, in a Meeting for about 31 
minutes, on Lunch for about 45 minutes and unavailable for another reason 
(Miscellaneous) for almost 13 minutes. The time spent in these four custom 
Unavailable states adds up to a total of 1 hour, 30 minutes and 44 seconds, as 
shown in the Unavailable column. 

 

Figure 79: Custom States Report  

For more information regarding Custom Agent States, please see the relating 
section, 1.5, which discusses how to create and utilize custom states 
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Section 3: OnTraQ Data Dictionary 
This section contains the OnTraQ Data Dictionary, a table listing all the data 
elements displayed in OnTraQ windows and reports. This is a valuable reference 
aid when you design your OnTraQ reports.   

The field value relations will include calls that are in queue but which haven’t had 
anything done to them yet, and these calls can move from one time period to the 
next. An example of this might be a call that is in queue in one quarter hour 
period but which doesn’t get answered until the next quarter hour period has 
begun. You might see totals of more calls in queue than were answered during a 
given quarter hour due to this.  

Service Group Report Calls Section: 

Received = (Incoming + Transfers In) 

Queued = (Received + Recycled) 

Queued = (Sent To Agent + System Transfers + Abandons Queue + Hang Ups + 
Disconnects) 

(Sent To Agent + Picked From Device) = (Answered + Unanswered + Abandons 
Agent + Agent Disconnects + Forwarded + Picked) 

IMPORTANT: Agent team results can’t be directly compared to service group 
results because a single call can be handled by more than one agent. For the 
service group a call is only answered once, but for the agent report when a call is 
transferred from one agent to another the second agent is also credited with 
answering a call. 

Agent Report Calls Section: 

Received = (Sent To Agent + Transfers To + Picked Up) 

Received = (Answered + Unanswered + Disconnects + Abandons + Forwarded + 
Picked) 

Agent Report Time In State Section: 

Total Login = (Idle + Talk + Work + Non-Call Work + Unavailable + Non-ACD + 
Other) 

 

 



 ONTR AQ US E R  GUI DE   

MAR CH  2017  IM P AC T  TE CH N O L OG I ES ,  I N C.  73 

3.1. Service Group Report 
Category Report Field Definition Description 
Calls Incoming calls_incoming ACD calls sent to this service group that 

have not been to any other service group 
on the same switch. 

Calls Received  calls_received  ACD calls sent to this service group that 
have not been routed to this service group 
before. 

Calls Recycled calls_queued – 
calls_received 

ACD calls sent to this service group that 
have been to this service group at least 
once before. 

Calls Transfers In calls_received – 
calls_incoming 

ACD calls sent to this service group, from 
another service group on the switch, that 
have not been to this service group before. 

Calls Queued calls_queued All ACD calls sent to service group queue 
during this period. 

Calls Sent To Agent calls_sent_to_agent ACD calls distributed from service group 
queue to an ACD agent. 

Calls Answered  calls_answered ACD calls answered by the initial agent 
after leaving the queue, including picked 
up calls (answered, but not by original 
agent).  Does not include calls answered 
by agents that were transferred from 
another agent. 

Calls % Answered calls_answered / 
calls_queued * 100 

Percent of ACD calls queued that were 
answered while in this queue. 

Calls Handled 
Elsewhere 

calls_handled_elsewhere ACD calls which were queued to this 
Service Group and one or more other 
Service Groups, which were then 
answered, picked, forwarded or 
disconnected from one of the other 
groups. 

Calls Disconnects calls_queue_disconnected 
+ 
calls_agent_disconnected 

ACD calls dropped by system or at an 
initial agent without being answered 
including when agent hangs up within 2 
seconds. 

Calls % Disconnects (calls_queue_disconnected 
+ 
calls_agent_disconnected) 
/ calls_queued * 100 

Percent of ACD calls queued that were 
disconnected. 

Calls Disconnects 
System 

calls_queue_disconnected  ACD calls dropped by system while in 
queue. 

Calls % Disconnects 
System 

calls_queue_disconnected 
/ calls_queued * 100 

Percent of ACD calls queued that were 
disconnected while in queue. 

Calls Disconnects 
Agent 

calls_agent_disconnected ACD calls dropped after assigned to an 
initial agent including agent hanging up 
within 2 seconds. 

Calls % Disconnects 
Agent 

calls_agent_disconnected / 
calls_queued * 100 

Percent of ACD calls queued that were 
disconnected after sent to an initial agent. 
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Category Report Field Definition Description 
Calls Unanswered calls_agent_unanswered ACD calls assigned to an initial agent that 

were never answered (ring no answer). 
Calls % Unanswered (calls_agent_unanswered) 

/ calls_queued * 100 
Percent of all ACD calls queued that were 
unanswered. 

Calls Abandons calls_queue_abandoned + 
calls_agent_abandoned 

ACD calls where caller quit waiting either in 
queue or while initial agent’s phone was 
ringing. 

Calls % Abandons (calls_queue_abandoned 
+ calls_agent_abandoned) 
/ calls_queued * 100 

Percent of ACD calls abandoned per calls 
handled. 

Calls Abandons 
Queue 

calls_queue_abandoned  ACD calls where caller quit waiting while in 
queue. 

Calls % Abandons 
Queue 

calls_queue_abandoned  / 
calls_queued * 100 

Percent of ACD calls abandoned while in 
queue per calls handled. 

Calls Abandons 
Agent 

calls_agent_abandoned ACD calls where caller quit waiting while 
initial agent’s phone was ringing. 

Calls % Abandons 
Agent 

calls_agent_abandoned / 
calls_queued * 100 

Percent of ACD calls queued that were 
abandoned after being sent to an initial 
agent. 

Calls Hang Ups calls_short_abandoned ACD calls where caller hung up instead of 
waiting in queue at least the defined 
Minimum Abandon threshold seconds. 

Calls % Hang Ups calls_short_abandoned / 
calls_queued * 100 

Percent of ACD calls where caller hung up 
instead of waiting in queue at least the 
defined Minimum Abandon threshold 
seconds. 

Calls Transfers calls_agent_transferred + 
calls_queue_transferred 

ACD calls transferred to another number, 
either by the system or an agent. 

Calls % Transfers (calls_agent_transferred + 
calls_queue_transferred) / 
calls_queued * 100 

Percent of ACD calls transferred compared 
to calls queued. 

Calls System 
Transfers 

calls_queue_transferred ACD calls transferred from queue instead 
of being distributed to an agent. 

Calls % System 
Transfers 

calls_queue_transferred / 
calls_queued * 100 

Percent of ACD calls transferred from 
queue. 

Calls Agent Transfers calls_agent_transferred ACD calls transferred after being answered 
by an agent. 

Calls % Agent 
Transfers 

calls_agent_transferred / 
calls_sent_to_agent * 100 

Percent of ACD calls sent to an agent that 
are transferred to another agent (includes 
calls transferred more than once). 

Calls Hold calls_held Number of ACD calls put on hold by an 
agent for first time in this period. 

Calls % Hold calls_held / 
calls_answered * 100 

Percent of ACD calls put on hold compared 
to calls answered. 

Calls Picked calls_to_agent_picked  
 

ACD calls that agent didn’t answer and 
were picked by another agent. Only 
counted for the first agent assigned to 
answer a call. 
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Category Report Field Definition Description 
Calls Picked From 

Device 
calls_agent_picked_up ACD calls to the service group that were 

System Transferred to a common device 
(such as a night answer bell) and then 
picked up by an ACD agent instead of 
being distributed directly to an ACD agent.  

Calls Forwarded calls_to_agent_forward ACD calls assigned to agent that were 
forwarded with no action by the assigned 
agent (such as forward on busy or on ring 
no answer). 

Calls Non-ACD non_acd_in_calls + 
non_acd_out_calls 

All calls directly to or from an agent, not 
through a service group. 

Calls Non-ACD In non_acd_in_calls An incoming call directly to an agent in this 
service group’s primary ACD group, not 
received through the service group. 

Calls Non-ACD In 
External 

non_acd_in_ext_calls An incoming call directly to an agent in this 
service group’s primary ACD group  from 
an external number (not an extension). 

Calls Non-ACD In 
Internal 

non_acd_in_calls - 
non_acd_in_ext_calls 

An incoming call directly to an agent in this 
service group’s primary ACD group from 
another extension. 

Calls Non-ACD Out non_acd_out_calls An outgoing call initiated by an agent in 
this service group’s primary ACD group. 

Calls Non-ACD Out 
External 

non_acd_out_ext_calls An outgoing call initiated by an agent in 
this service group’s primary ACD group to 
an external number. 

Calls Non-ACD Out 
Internal 

non_acd_out_calls – 
non_acd_out_ext_calls 

An outgoing call initiated by an agent in 
this service group’s primary ACD group to 
another extension. 

Calls External calls_answered + 
non_acd_in_ext_calls + 
non_acd_out_ext_calls 

All external calls involving an agent in this 
service group’s primary ACD group, 
includes ACD and Non-ACD calls. 

Calls 2nd Line Non-
ACD 

calls_2nd_line_in_ext + 
calls_2nd_line_in_int + 
calls_2nd_line_out_ext + 
calls_2nd_line_out_int 

All calls directly to or from the 2nd line of 
an agent, not through a service group. 

Calls 2nd Line Non-
ACD In 

calls_2nd_line_in_ext + 
calls_2nd_line_in_int 

An incoming call directly to the 2nd line of 
an agent in this service group’s primary 
ACD group, not received through the 
service group. 

Calls 2nd Line Non-
ACD In 
External 

calls_2nd_line_in_ext An incoming call directly to the 2nd line of 
an agent in this service group’s primary 
ACD group from an external number (not 
an extension). 

Calls 2nd Line Non-
ACD In Internal 

calls_2nd_line_in_int An incoming call directly to the 2nd line of 
an agent in this service group’s primary 
ACD group from another extension. 

Calls 2nd Line Non-
ACD Out 

calls_2nd_line_out_ext + 
calls_2nd_line_out_int 

An outgoing call initiated by an agent on 
their 2nd line in this service group’s primary 
ACD group. 
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Category Report Field Definition Description 
Calls 2nd Line Non-

ACD Out 
External 

calls_2nd_line_out_ext An outgoing call initiated by an agent on 
their 2nd line in this service group’s primary 
ACD group to an external number. 

Calls 2nd Line Non-
ACD Out 
Internal 

calls_2nd_line_out_int An outgoing call initiated by an agent on 
their 2nd line in this service group’s primary 
ACD group to an internal number. 

Calls 2nd Line Talk calls_2nd_line_talk ACD calls transferred to an agent’s 2nd line 
and answered by an agent in this service 
group’s primary ACD group. 

Time per 
Call 

Talk talk_time / calls_answered Talk time per ACD call answered. 

Time per 
Call 

Work after_call_work_time / 
calls_answered 

After call work per ACD call answered. 
Either the switch must be configured to 
automatically go into after call work after 
each call, or the agent must manually start 
the work state before the customer hangs 
up. If the phone goes to idle or off-hook 
and any work state entered at the point is 
recorded as Non-Call Work. 

Time per 
Call 

ACD Call 
Handling 

(talk_time + 
after_call_work_time) / 
calls_answered 

Total time on ACD calls per call answered. 

Time per 
Call 

Hold hold_time / calls_held Time on hold per calls put on hold. 

Time per 
Call 

Non-ACD (non_acd_in_time + 
non_acd_out_time) / 
(non_acd_in_calls + 
non_acd_out_calls) 

Time on non-ACD calls per non-ACD calls. 

Time per 
Call 

Non-ACD In non_acd_in_time / 
non_acd_in_calls 

Time on non-ACD incoming calls per non-
ACD incoming calls. 

Time per 
Call 

Non-ACD In 
External 

non_acd_in_ext_time / 
non_acd_in_ext_calls 

Time on non-ACD incoming external calls 
per non-ACD incoming external calls. 

Time per 
Call 

Non-ACD In 
Internal 

(non_acd_in_time – 
non_acd_in_ext_time) / 
non_acd_in_calls – 
non_acd_in_ext_calls) 

Time on non-ACD incoming internal calls 
per non-ACD incoming internal calls. 

Time per 
Call 

Non-ACD Out non_acd_out_time / 
non_acd_out_calls 

Time on non-ACD outgoing calls per non-
ACD outgoing calls. 

Time per 
Call 

Non-ACD Out 
External 

non_acd_out_ext_time / 
non_acd_out_ext_call 

Time on non-ACD outgoing external calls 
per non-ACD outgoing external calls. 

Time per 
Call 

Non-ACD Out 
Internal 

(non_acd_out_time - 
non_acd_out_ext_time) / 
(non_acd_out_calls - 
non_acd_out_ext_calls) 

Time on non-ACD outgoing internal calls 
per non-ACD outgoing internal calls. 

Time per 
Call 

External (talk_time + 
after_call_work_time + 
non_acd_out_ext_time + 
non_acd_in_ext_time) / 
(calls_answered + 
non_acd_out_ext_calls + 
non_acd_in_ext_calls) 

Time on ACD and non-ACD calls per ACD 
and non-ACD calls. 
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Category Report Field Definition Description 
Time per 
Call 

2nd Line Non-
ACD 

 (time_2nd_line_in_ext + 
time_2nd_line_in_int + 
time_2nd_line_out_ext + 
time_2nd_line_out_int) / 
(calls_2nd_line_in_ext + 
calls_2nd_line_in_int + 
calls_2nd_line_out_ext + 
calls_2nd_line_out_int) 

Time on calls directly to or from the 2nd 
line of an agent, not through a service 
group. 

Time per 
Call 

2nd Line Non-
ACD In 

(time_2nd_line_in_ext + 
time_2nd_line_in_int) / 
(calls_2nd_line_in_ext + 
calls_2nd_line_in_int) 

Time on incoming calls directly to the 2nd 
line of an agent in this service group’s 
primary ACD group, not received through 
the service group. 

Time per 
Call 

2nd Line Non-
ACD In 
External 

time_2nd_line_in_ext / 
calls_2nd_line_in_ext 

Time on incoming calls directly to the 2nd 
line of an agent in this service group’s 
primary ACD group from an external 
number (not an extension). 

Time per 
Call 

2nd Line Non-
ACD In Internal 

time_2nd_line_in_int / 
calls_2nd_line_in_int 

Time on incoming calls directly to the 2nd 
line of an agent in this service group’s 
primary ACD group from another 
extension. 

Time per 
Call 

2nd Line Non-
ACD Out 

(time_2nd_line_out_ext + 
calls_2nd_line_out_int) / 
(time_2nd_line_out_ext + 
calls_2nd_line_out_int) 

Time on outgoing calls initiated by an 
agent on their 2nd line in this service 
group’s primary ACD group. 

Time per 
Call 

2nd Line Non-
ACD Out 
External 

time_2nd_line_out_ext / 
calls_2nd_line_out_ext 

Time on outgoing calls initiated by an 
agent on their 2nd line in this service 
group’s primary ACD group to an external 
number. 

Time per 
Call 

2nd Line Non-
ACD Out 
Internal 

time_2nd_line_out_int / 
calls_2nd_line_out_int 

Time on outgoing calls initiated by an 
agent on their 2nd line in this service 
group’s primary ACD group to an internal 
number. 

Time per 
Call 

2nd Line Talk time_2nd_line_talk / 
calls_2nd_line_talk 

Time on ACD calls transferred to an 
agent’s 2nd line and answered by an agent 
in this service group’s primary ACD group. 

Time in 
ACD State 

Total Login idle_time  + talk_time + 
non_call_work_time + 
after_call_work_time + 
unavail_time + 
non_acd_out_time + 
non_acd_in_time + 
other_time 

Time agents spent logged in. For service 
group, just agents in primary ACD group. 
 
For service group pool, all agents that can 
service group. 

Time in 
ACD State  

ACD Call 
Handling 

talk_time + 
after_call_work_time 

Total time agents spent on ACD calls to 
this service group during this period. 

Time in 
ACD State 

% Occupancy (talk_time + 
after_call_work_time) / 
(talk_time + 
after_call_work_time + 
idle_time) * 100 

Percent of time agents were available to 
take ACD calls that was spent on calls to 
this service group during this period. 
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Category Report Field Definition Description 
Time in 
ACD State 

% Total Call 
Handling 

(talk_time + 
after_call_work_time + 
non_acd_out_time + 
non_acd_in_time) / Total 
Time in State * 100 

Percent of logged in time that agents spent 
on calls for this service group and non- 
service group related business. 

Time in 
ACD State 

% External Call 
Handling  

(talk_time + 
after_call_work_time + 
non_acd_out_ext_time + 
non_acd_in_ext_time) / 
logged_in_time * 100 

Percent of logged in time that agents spent 
on calls for this service group and external 
calls for non-service group related 
business. 

Time in 
ACD State 

% Available (talk_time + 
after_call_work_time + 
idle_time) / Total Time in 
State * 100 

Percent of time agents were logged in that 
they were available to take calls for this 
service group. 

Time in 
ACD State 

Talk talk_time Time agent spends on the call, from when 
the call is answered to when the agent’s 
phone is disconnected from the call.  

Time in 
ACD State 

Work after_call_work_time Time agents spent on after call work for 
calls to this service group. Either the 
switch must be configured to automatically 
go into after call work after each call, or 
the agent must manually start the work 
state before the customer hangs up. If the 
phone goes to idle or off-hook and any 
work state entered at the point is recorded 
as Non-Call Work. (Note: If leveraging 
custom work states, please see Custom 
Agent States section for more 
information.) 

Time in 
ACD State 

Queue total_queue_time Time ACD call spent in queue, for all 
queued calls regardless of how each call 
left the queue. 

Time in 
ACD State 

Answer answer_time Time ACD calls spent waiting to be 
answered.  Includes time in queue and 
time ringing. Does not include any time for 
calls that were not answered. 

Time in 
ACD State 

Non-Call Work non_call_work_time Time agents spent on non-call work. 
(Note: If leveraging custom work states, 
please see Custom Agent States section 
for more information.) 

Time in 
ACD State 

Unavailable unavail_time Time agents spent unavailable. (Note: If 
leveraging custom unavailable states, 
please see Custom Agent States section 
for more information.) 

Time in 
ACD State 

Non-ACD non_acd_out_time + 
non_acd_in_time 

Time agents spent on non-ACD calls. 

Time in 
ACD State 

Non-ACD In non_acd_in_time Time agents spent on incoming non-ACD 
calls. 

Time in 
ACD State 

Non-ACD Out non_acd_out_time Time agents spent on outgoing non-ACD 
calls. 

Time in 
ACD State 

Non-ACD In 
External 

non_acd_in_ext_time Time agents spent on incoming non-ACD 
calls from external numbers. 



 ONTR AQ US E R  GUI DE   

MAR CH  2017  IM P AC T  TE CH N O L OG I ES ,  I N C.  79 

Category Report Field Definition Description 
Time in 
ACD State 

Non-ACD Out 
External 

non_acd_out_ext_time Time agents spent on outgoing non-ACD 
calls to external numbers. 

Time in 
ACD State 

Non-ACD In 
Internal 

non_acd_in_time – 
non_acd_in_ext_time 

Time agents spent on incoming non-ACD 
calls from extensions, not external 
numbers. 

Time in 
ACD State  

Non-ACD Out 
Internal 

non_acd_out_time – 
non_acd_out_ext_time 

Time agents spent on outgoing non-ACD 
calls to extensions, not external numbers. 

Time in 
ACD State  

Other  other_time Time agent’s phone spent in misc. states 
such as Ringing and off hook.  

Time in 
ACD State  

Hold hold_time Time ACD calls spent on hold. 

Time in 
ACD State 

Idle idle_time Time agents spent waiting for a call. 

Time in 
ACD State 

2nd Line Non-
ACD 

time_2nd_line_in_ext + 
time_2nd_line_in_int + 
time_2nd_line_out_ext + 
time_2nd_line_out_int 

Time agents spent on calls directly to or 
from the 2nd line of an agent, not through 
a service group. 

Time in 
ACD State 

2nd Line Non-
ACD In 

time_2nd_line_in_ext + 
time_2nd_line_in_int 

Time agents spent on incoming calls 
directly to the 2nd line of an agent in this 
service group’s primary ACD group, not 
received through the service group. 

Time in 
ACD State 

2nd Line Non-
ACD In 
External 

time_2nd_line_in_ext Time agents spent on incoming calls 
directly to the 2nd line of an agent in this 
service group’s primary ACD group from an 
external number (not an extension). 

Time in 
ACD State 

2nd Line Non-
ACD In Internal 

time_2nd_line_in_int Time agents spent on incoming calls 
directly to the 2nd line of an agent in this 
service group’s primary ACD group from 
another extension. 

Time in 
ACD State 

2nd Line Non-
ACD Out 

time_2nd_line_out_ext + 
calls_2nd_line_out_int 

Time agents spent on outgoing calls 
initiated by an agent on their 2nd line in 
this service group’s primary ACD group. 

Time in 
ACD State 

2nd Line Non-
ACD Out 
External 

time_2nd_line_out_ext Time agents spent on outgoing calls 
initiated by an agent on their 2nd line in 
this service group’s primary ACD group to 
an external number. 

Time in 
ACD State 

2nd Line Non-
ACD Out 
Internal 

time_2nd_line_out_int Time agents spent on outgoing calls 
initiated by an agent on their 2nd line in 
this service group’s primary ACD group to 
an internal number. 

Time in 
ACD State 

2nd Line Talk time_2nd_line_talk Time agents spent on ACD calls transferred 
to an agent’s 2nd line and answered by an 
agent in this service group’s primary ACD 
group. 
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Category Report Field Definition Description 
Service 
Levels 

Average Time 
in Queue  

queue_time / 
(calls_sent_to_agent- 
calls_agent_unanswered – 
calls_agent_abandoned) 

Average time in queue per ACD call, for 
calls that have been sent to an ACD agent 
during this period but were not 
unanswered or abandoned at agent. If 
“Use Caller Experience for Service Level” 
box checked for Service Group, the time 
calculated based on the total queue time 
as call potentially passes through multiple 
queues before being answered by a 
monitored station. 

Service 
Levels 

% Answered 
within Service 
Level 

calls_service_level_met  / 
calls_answered * 100 
 

Percent of ACD calls answered during this 
period that met the answer service level. If 
“Use Caller Experience for Service Level” 
box checked for Service Group, the time 
calculated based on the total time elapsed 
since the call entered the ACD system 
(caller experience), as a call potentially 
passes through multiple queues before 
being answered. 

Service 
Levels 

Maximum Calls 
in Queue 

max_calls_in_queue The maximum number of calls that were 
queued for this service group during this 
period. 

Service 
Levels 

Maximum Time 
in Queue (secs) 

max_call_queued_time The longest time that any call was queue 
for this service group during this period. 

Service 
Levels 

Maximum 
Abandon Time 
(secs) 

max_abandon_time The longest time that any call was 
queued/ringing before abandoned while 
waiting in this service group during this 
period. Time may include time queued for 
previous service groups for the call. 

Service 
Levels 

Average 
Abandon Time 
(secs) 

abandon_time / 
(calls_agent_abandoned + 
calls_queue_abandoned) 

Average time that calls were 
queued/ringing before abandoned while 
waiting in this service group during this 
period. Time may include time queued for 
previous service groups for calls. 

3.2. Agent Reports 
Category Report Field Definition  Description 
Calls Received calls_answered + 

calls_agent_unanswered + 
calls_agent_disconnected 
+ 
calls_agent_abandoned + 
calls_to_agent_forward + 
calls_to_agent_picked 

All ACD calls received by an agent. 
Includes calls transferred from other 
agents and calls agent picked up. 

Calls From Queue  calls_sent_to_agent ACD calls sent to agent or agent team 
from a service group queue during this 
period. 
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Category Report Field Definition  Description 
Calls Transfers To  Received – 

(calls_sent_to_agent + 
calls_agent_picked_up) 

ACD calls transferred to the agent, usually 
by another agent. (Not distributed directly 
from a service group and not picked up by 
the agent). 

Calls Answered  calls_answered ACD calls agents or agent team answered 
including picked up calls (answered, but 
not by original agent) and calls transferred 
by another agent. 

Calls % Answered calls_answered / Received 
* 100 

Percent of calls to agent that were 
answered. 

Calls Unanswered calls_agent_unanswered ACD calls, sent to agent, that were not 
answered. 

Calls % Unanswered calls_agent_unanswered / 
Received * 100 

Percent of ACD calls sent to agent not 
answered. 

Calls Abandons calls_agent_abandoned ACD calls where caller hung-up the call 
after sent to an agent. 

Calls % Abandons calls_agent_abandoned / 
Received * 100 

Percent of ACD calls received abandoned 
by caller. 

Calls Disconnects calls_agent_disconnected ACD calls disconnected by system after 
assigned to an agent or agent hung up on 
caller < 2 seconds. 

Calls % Disconnects calls_agent_disconnected / 
Received  * 100 

Percent of ACD calls received that were 
disconnected. 

Calls Hold calls_held ACD calls put on hold by an agent for the 
first time during this period. 

Calls % Hold calls_held / 
calls_answered * 100 

Percent of ACD calls answered that were 
put on hold. 

Calls Transfers calls_agent_transferred ACD calls where agent ended the call by 
transferring it to another station. 

Calls %  Transfers calls_agent_transferred / 
calls_answered * 100 

Percent of ACD calls answered that were 
transferred. 

Calls Forwarded calls_to_agent_forward ACD calls assigned to agent that were 
forwarded without any action by the 
assigned agent (such as forward on busy 
or on ring no answer, not a transfer). 

Calls Picked calls_to_agent_picked  
 

ACD calls that the agent didn’t answer and 
were picked by another agent. 

Calls Picked Up calls_agent_picked_up ACD Calls to other agents that the agent 
picked up before they were answered by 
the original agents. 

Calls Non-ACD non_acd_in_calls + 
non_acd_out_calls 

All calls directly to or from an agent, not 
through a service group. 

Calls Non-ACD In non_acd_in_calls An incoming call directly to agent, not 
through a service group. 

Calls Non-ACD In 
External 

non_acd_in_ext_calls An incoming call directly to agent from an 
external number (not an extension). 

Calls Non-ACD In 
Internal 

non_acd_in_calls - 
non_acd_in_ext_calls 

An incoming call directly to agent from 
another extension. 

Calls Non-ACD Out non_acd_out_calls An outgoing call initiated by the agent. 
Calls Non-ACD Out 

External 
non_acd_out_ext_calls An outgoing call initiated by the agent to 

an external number. 
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Category Report Field Definition  Description 
Calls Non-ACD Out 

Internal 
non_acd_out_calls – 
non_acd_out_ext_calls 

An outgoing call initiated by the agent to 
another extension. 

Calls External calls_answered + 
non_acd_in_ext_calls + 
non_acd_out_ext_calls 

All external calls involving the agent, 
includes ACD and Non-ACD calls. 

Calls 2nd Line Non-
ACD 

calls_2nd_line_in_ext + 
calls_2nd_line_in_int + 
calls_2nd_line_out_ext + 
calls_2nd_line_out_int 

All calls directly to or from the 2nd line of 
the agent, not through a service group. 

Calls 2nd Line Non-
ACD In 

calls_2nd_line_in_ext + 
calls_2nd_line_in_int 

An incoming call directly to the 2nd line of 
the agent, not received through the service 
group. 

Calls 2nd Line Non-
ACD In 
External 

calls_2nd_line_in_ext An incoming call directly to the 2nd line of 
the agent from an external number (not an 
extension). 

Calls 2nd Line Non-
ACD In Internal 

calls_2nd_line_in_int An incoming call directly to the 2nd line of 
the agent from another extension. 

Calls 2nd Line Non-
ACD Out 

calls_2nd_line_out_ext + 
calls_2nd_line_out_int 

An outgoing call initiated by the agent on 
their 2nd line. 

Calls 2nd Line Non-
ACD Out 
External 

calls_2nd_line_out_ext An outgoing call initiated by the agent on 
their 2nd line to an external number. 

Calls 2nd Line Non-
ACD Out 
Internal 

calls_2nd_line_out_int An outgoing call initiated by the agent on 
their 2nd line to an internal number. 

Calls 2nd Line Talk calls_2nd_line_talk ACD calls transferred to the agent’s 2nd line 
and answered by the agent. 

Time Per 
Call 

Talk talk_time / calls_answered Average talk time in seconds per ACD call 
answered. 

Time Per 
Call 

Talk % of 
Group 

Talk for object / Talk for 
parent object * 100 

Object’s average Talk Time as percent of 
parent object’s average Talk Time. 

Time Per 
Call 

Work after_call_work_time / 
calls_answered 

Average after call work time in time per 
call answered. Either the switch must be 
configured to automatically go into after 
call work after each call, or the agent must 
manually start the work state before the 
customer hangs up. If the phone goes to 
idle or off-hook and any work state 
entered at the point is recorded as Non-
Call Work. 

Time Per 
Call 

Work % of 
Group 

Work for Object / Work for 
parent object * 100 

Object’s average After Call Work Time as 
percent of parent object’s average After 
Call Work Time. 

Time Per 
Call 

ACD Call 
Handling 

(talk_time + 
after_call_work_time) / 
calls_answered 

Average total time on ACD calls in time. 

Time Per 
Call 

ACD Call 
Handling % of 
Group 

Total for obj / total for 
parent object * 100 

Agent’s average ACD Call Handing time as 
percent of group’s average ACD Call 
Handling Time. 

Time per 
Call 

Hold hold_time / calls_held Time on hold per calls put on hold. 



 ONTR AQ US E R  GUI DE   

MAR CH  2017  IM P AC T  TE CH N O L OG I ES ,  I N C.  83 

Category Report Field Definition  Description 
Time per 
Call 

Non-ACD (non_acd_in_time + 
non_acd_out_time) / 
(non_acd_in_calls + 
non_acd_out_calls) 

Time on non-ACD calls per non-ACD calls. 

Time per 
Call 

Non-ACD In non_acd_in_time / 
non_acd_in_calls 

Time on non-ACD incoming calls per non-
ACD incoming calls. 

Time per 
Call 

Non-ACD In 
External 

non_acd_in_ext_time / 
non_acd_in_ext_calls 

Time on non-ACD incoming external calls 
per non-ACD incoming external calls. 

Time per 
Call 

Non-ACD In 
Internal 

(non_acd_in_time – 
non_acd_in_ext_time) / 
non_acd_in_calls – 
non_acd_in_ext_calls) 

Time on non-ACD incoming internal calls 
per non-ACD incoming internal calls. 

Time per 
Call 

Non-ACD Out non_acd_out_time / 
non_acd_out_calls 

Time on non-ACD outgoing calls per non-
ACD outgoing calls. 

Time per 
Call 

Non-ACD Out 
External 

non_acd_out_ext_time / 
non_acd_out_ext_call 

Time on non-ACD outgoing external calls 
per non-ACD outgoing external calls. 

Time per 
Call 

Non-ACD Out 
Internal 

(non_acd_out_time - 
non_acd_out_ext_time) / 
(non_acd_out_calls - 
non_acd_out_ext_calls) 

Time on non-ACD outgoing internal calls 
per non-ACD outgoing internal calls. 

Time per 
Call 

External (talk_time + 
after_call_work_time + 
non_acd_out_ext_time + 
non_acd_in_ext_time) / 
(calls_answered + 
non_acd_out_ext_calls + 
non_acd_in_ext_calls) 

Time on ACD and non-ACD calls per ACD 
and non-ACD calls. 

Time per 
Call 

2nd Line Non-
ACD 

 (time_2nd_line_in_ext + 
time_2nd_line_in_int + 
time_2nd_line_out_ext + 
time_2nd_line_out_int) / 
(calls_2nd_line_in_ext + 
calls_2nd_line_in_int + 
calls_2nd_line_out_ext + 
calls_2nd_line_out_int) 

Time on calls directly to or from the 2nd 
line of the agent, not through a service 
group. 

Time per 
Call 

2nd Line Non-
ACD In 

(time_2nd_line_in_ext + 
time_2nd_line_in_int) / 
(calls_2nd_line_in_ext + 
calls_2nd_line_in_int) 

Time on incoming calls directly to the 2nd 
line of the agent, not received through the 
service group. 

Time per 
Call 

2nd Line Non-
ACD In 
External 

time_2nd_line_in_ext / 
calls_2nd_line_in_ext 

Time on incoming calls directly to the 2nd 
line of the agent from an external number 
(not an extension). 

Time per 
Call 

2nd Line Non-
ACD In Internal 

time_2nd_line_in_int / 
calls_2nd_line_in_int 

Time on incoming calls directly to the 2nd 
line of the agent from another extension. 

Time per 
Call 

2nd Line Non-
ACD Out 

(time_2nd_line_out_ext + 
calls_2nd_line_out_int) / 
(time_2nd_line_out_ext + 
calls_2nd_line_out_int) 

Time on outgoing calls initiated by the 
agent on their 2nd line. 

Time per 
Call 

2nd Line Non-
ACD Out 
External 

time_2nd_line_out_ext / 
calls_2nd_line_out_ext 

Time on outgoing calls initiated by the 
agent on their 2nd line to an external 
number. 
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Category Report Field Definition  Description 
Time per 
Call 

2nd Line Non-
ACD Out 
Internal 

time_2nd_line_out_int / 
calls_2nd_line_out_int 

Time on outgoing calls initiated by the 
agent on their 2nd line to an internal 
number. 

Time per 
Call 

2nd Line Talk time_2nd_line_talk / 
calls_2nd_line_talk 

Time on ACD calls transferred to the 
agent’s 2nd line and answered by the 
agent. 

Time in 
ACD State 

Total Login logged_in_time Total time agent or agent team logged in 
during this period. 

Time in  
ACD State 

First Login first_login_time  First time agent or any agent in ACD group 
logged in during this period 

Time in  
ACD State 

Last Login last_login_time Last time agent or any agent in ACD group 
logged out during this period 

Time in 
ACD State  

ACD Call 
Handling 

talk_time + 
after_call_work_time 

Total time spent on ACD calls during this 
period. 

Time in 
ACD State 

% Occupancy (talk_time + 
after_call_work_time) / 
(talk_time + 
after_call_work_time + 
idle_time) * 100 

Percent of time agent was available to take 
ACD calls that was spent on ACD calls 
during this period. 

Time in 
ACD State 

% Available (talk_time + 
after_call_work_time + 
idle_time) / 
logged_in_time * 100 

Percent of time agent logged in time that 
they were available to take ACD calls 
during this period. 

Time in 
ACD State 

% Total Call 
Handling 

(talk_time + 
after_call_work_time + 
non_acd_out_time + 
non_acd_in_time) / 
logged_in_time * 100 

Percent of logged in time that agent spent 
on calls during this period. 

Time in 
ACD State 

% External Call 
Handling  

(talk_time + 
after_call_work_time + 
non_acd_out_ext_time + 
non_acd_in_ext_time) / 
logged_in_time * 100 

Percent of logged in time agent or agent 
team spent handling external calls. 

Time in 
ACD State 

Talk talk_time Total time agent or agent team spent on 
ACD calls during this period. 

Time in 
ACD State 

Work after_call_work_time Total time agent or agent team in after call 
work state during this period. Either the 
switch must be configured to automatically 
go into after call work after each call, or 
the agent must manually start the work 
state before the customer hangs up. If the 
phone goes to idle or off-hook and any 
work state entered at the point is recorded 
as Non-Call Work. (Note: If leveraging 
custom work states, please see Custom 
Agent States section for more 
information.) 

Time in 
ACD State 

Answer answer_time Time ACD calls spent waiting to be 
answered. Includes time in queue and time 
ringing. Does not include any time for calls 
that were not answered. 
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Category Report Field Definition  Description 
Time in 
ACD State 

Hold hold_time Time agent or agent team left ACD calls on 
hold. 

Time in 
ACD State 

Non-Call Work non_call_work_time Total time agent or agent team in non-call 
work state during this period. (Note: If 
leveraging custom work states, please see 
Custom Agent States section for more 
information.) 

Time in 
ACD State 

% Non-Call 
Work 

non_call_work_time / 
logged_in_time * 100 

Percent of logged in time that agents spent 
on non-call work. 

Time in 
ACD State 

Idle idle_time Total time agent or agent team in idle 
state during this period. 

Time in 
ACD State 

% Idle idle_time / logged_in_time 
* 100 

Percent of logged in time that agents spent 
waiting for a call. 

Time in 
ACD State 

Unavailable unavail_time Total time agent or agent team unavailable 
during this period. (Note: If leveraging 
custom work states, please see Custom 
Agent States section for more 
information.) 

Time in 
ACD State 

% Unavailable unavail_time / 
logged_in_time * 100 

Percent of total time spent in unavailable 
state by agents. 

Time in 
ACD State 

Non-ACD non_acd_out_time + 
non_acd_in_time 

Time agents spent on non-ACD calls. 

Time in 
ACD State 

% Non-ACD (non_acd_out_time + 
non_acd_in_time) / 
logged_in_time * 100 

Percent of total time spent on non-ACD 
calls. 

Time in 
ACD State 

Non-ACD In non_acd_in_time Time agents spent on incoming non-ACD 
calls. 

Time in 
ACD State 

Non-ACD Out non_acd_out_time Time agents spent on outgoing non-ACD 
calls. 

Time in 
ACD State 

Non-ACD In 
External 

non_acd_in_ext_time Time agents spent on incoming non-ACD 
calls from external numbers. 

Time in 
ACD State 

Non-ACD Out 
External 

non_acd_out_ext_time Time agents spent on outgoing non-ACD 
calls to external numbers. 

Time in 
ACD State 

Non-ACD In 
Internal 

non_acd_in_time – 
non_acd_in_ext_time 

Time agents spent on incoming non-ACD 
calls from extensions, not external 
numbers. 

Time in 
ACD State 

Non-ACD Out 
Internal 

non_acd_out_time – 
non_acd_out_ext_time 

Time agents spent on outgoing non-ACD 
calls to extensions, not external numbers. 

Time in 
ACD State 

Other other_time Total time agent or agent team spent in 
other state (mostly ringing and off hook 
while dialing) during this period. 

Time in 
ACD State 

% Other other_time / 
logged_in_time * 100 

Percent of total time spent in other state. 

Time in 
ACD State 

2nd Line Non-
ACD 

time_2nd_line_in_ext + 
time_2nd_line_in_int + 
time_2nd_line_out_ext + 
time_2nd_line_out_int 

Time agents spent on calls directly to or 
from the 2nd line of an agent, not through 
a service group. 

Time in 
ACD State 

2nd Line Non-
ACD In 

time_2nd_line_in_ext + 
time_2nd_line_in_int 

Time agents spent on incoming calls 
directly to the 2nd line of an agent, not 
received through the service group. 
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Category Report Field Definition  Description 
Time in 
ACD State 

2nd Line Non-
ACD In 
External 

time_2nd_line_in_ext Time agents spent on incoming calls 
directly to the 2nd line of an agent from an 
external number (not an extension). 

Time in 
ACD State 

2nd Line Non-
ACD In Internal 

time_2nd_line_in_int Time agents spent on incoming calls 
directly to the 2nd line of an agent from 
another extension. 

Time in 
ACD State 

2nd Line Non-
ACD Out 

time_2nd_line_out_ext + 
calls_2nd_line_out_int 

Time agents spent on outgoing calls 
initiated by an agent on their 2nd line. 

Time in 
ACD State 

2nd Line Non-
ACD Out 
External 

time_2nd_line_out_ext Time agents spent on outgoing calls 
initiated by an agent on their 2nd line to an 
external number. 

Time in 
ACD State 

2nd Line Non-
ACD Out 
Internal 

time_2nd_line_out_int Time agents spent on outgoing calls 
initiated by an agent on their 2nd line to an 
internal number. 

Time in 
ACD State 

2nd Line ACD 
Talk 

time_2nd_line_talk Time agents spent on ACD calls transferred 
to an agent’s 2nd line and answered by an 
agent. 
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Section 4: Appendix: Menu options 
There are six menus in OnTraQ: File, Edit, View, Tools, Window, and Help. 
These are discussed below. 

4.1. File Menu 
The following options are available on the File menu:  

• Open Report File – open a saved report file. 

• Server names – select the OnTraQ server from the list of server names 
displayed here. You may log into multiple servers at the same time. The 
list of servers available depends on your access rights.  If your system 
includes redundant servers to optimize availability, only log into one 
server at a time.  If the primary server fails, log out and log into 
redundant server.  

• Configure OnTraQ Servers – this displays the OnTraQ Servers window. 
You can select a server from this window and edit the information that 
OnTraQ uses to connect to that server. Note that this is restricted to 
administrative users.   

• Logout – logs you out of OnTraQ but does not close OnTraQ. 

• Exit – logs you out of OnTraQ and also closes OnTraQ.  

4.2. Edit Menu 
The following options are available on the Edit menu:  

• Copy – allows you to copy an object in OnTraQ (if that object can be 
copied). 

• Paste – allows you to paste copied information or an object (if that action 
is allowed). 

• Rename – allows you rename an object (if renaming is allowed).  

4.3. View Menu 
The following options are available on the View menu: 

• Change Alarm Colors/Sounds – allows you to change the color-coding 
and sounds used for alarms. 

• Small, Medium, and Large Fonts – allows you to select the size of the 
font OnTraQ uses. 
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4.4. Tools Menu 
The following options are available on the Tools menu: 

• Report Templates – displays the Report Template pane and allows you 
to create new report folders and delete report templates.  

• Scheduled Activities – displays the Scheduled Activities pane and lets 
you create new scheduled activities and delete or make inactive currently 
scheduled activities. 

• ACD Object Access – lets you select OnTraQ users and limit their ability 
to view objects in OnTraQ. For example, you can limit a shift leader’s 
view to his or her agents only. This option is for administrative users 
only. Other users will not see it as a menu option.  

• Alarm Thresholds – lets you define the alarm thresholds for Service 
Groups and Agents, including all Service Groups or individual ones. You 
can also use the Clear All Entries option to erase the current thresholds 
for an Agent or Service Group. 

• ANI/DNIS Group – lets you define rules that associate calls with 
appropriate ANI/DNIS groups. This option is for administrative users 
only. Other users will not see it as a menu option. 

• Transaction Codes – lets you define within OnTraQ the transaction 
codes defined on your switch. OnTraQ needs to have these codes 
defined before you can create any Transaction Code reports. This option 
is for administrative users only. Other users will not see it as a menu 
option. 

• OnTraQ Servers – lets you define the server properties that OnTraQ 
uses to retrieve information from the Traffic Analyst database. 

• System Preferences – lets you define your Session Boundaries (these 
typically correspond to your workshifts), the Time-In-Queue-Bands (the 
boundaries that define a queue, the Data Storage Timeframes for the 
Life of Call and Event Logs, and the URL location of the Traffic Analyst 
database, which OnTraQ needs to have to collect switch data.  

• Custom Agent States – lets you define up to 20 custom Work and 
Unavailable states for your agents. This option is for administrative users 
only. (see 1.5 for more details) 

4.5. Window Menu 
The following options are available on the Window menu 

• Agent Team Explorer – displays the Agent Team Explorer 

• Service Group Explorer - displays the Service Group Explorer 
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• Service Group Status – displays the Service Group Status pane, which 
displays real-time statistics for your Service Groups 

• Close Window Layout – this closes all the OnTraQ panes.  

• Default Window Layout – this reverts to the default OnTraQ layout. 

• Save Window Layout – this saves your current layout. Whenever you 
login to OnTraQ the saved layout is automatically displayed. 
 
Note: Multiple historical reports cannot be saved to the window layout. 

• [any open panes] – if you have any other panes open those panes will be 
listed here. Click on one to bring it to the front of the OnTraQ tablet.  

4.6. Help Menu 
The following options are available on the Help menu 

• OnTraQ Help… – displays a web link to OnTraQ documentation. 

• About OnTraQ… – displays software version information about OnTraQ. 
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